This chapter contains the information you need to install either the Apple Remote Access Client or Apple Remote Access Personal Server version of Apple Remote Access 3.0.

Use Apple Remote Access Client to dial in to a remote server and gain access to your company’s local area network (LAN) or to connect to an Internet Service Provider (ISP) that gives you dial-up access to the vast resources of the Internet and the World Wide Web.

Use Apple Remote Access Personal Server to make the same dial-up connections available in Apple Remote Access Client and to set up your computer as a dial-in server that can answer calls from other computers.

Before you can connect to a network

Installing Apple Remote Access is just one of the things you must do before you can connect to a network. In addition, you need to:

- Make sure your computer has an internal modem or connect it to an external modem, following the instructions that came with your modem. Buy the fastest modem you can afford, especially if you are planning to transfer files or use the Internet.
- Connect the modem to a telephone line.
- Get an account on the server to which you are planning to connect. Some servers let callers without accounts log in as “Guest.” Ask your ISP or network administrator what options are available.
- If you have an account, obtain your user name and password from your network administrator or ISP.
- For a TCP/IP connection, ask your administrator what options you should set in the TCP/IP control panel. See Chapter 2 for further instructions.
What you need to get started

Apple Remote Access 3.0 requires the following hardware and software:

- a computer with a 68030, 68040, or PowerPC™ microprocessor
- Mac OS version 7.1 through 7.1.2
  or
  Mac OS version 7.5.3 or later (not earlier versions of system 7.5)
- at least 8 megabytes (MB) of RAM (16 MB are recommended) if your computer is using Mac OS 7.6 or later
- Open Transport version 1.1.1 or later
- a Hayes-compatible modem with a data transfer rate of at least 9600 bits per second. (A 28.8 kbps or higher-speed modem is recommended.)
  or
  an ISDN adapter
- A modem script (CCL) that is compatible with both your modem and Remote Access 3.0

Depending on the system software installed on your computer, you may have to install Open Transport or an updated version of Open Transport before you can install Apple Remote Access 3.0.

To identify the version of Open Transport running on your computer, open either the AppleTalk or the TCP/IP control panel and choose Info from the File menu (or press ⌘-I). A dialog box appears, displaying the version number of Open Transport.

<table>
<thead>
<tr>
<th>If you have</th>
<th>Install</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mac OS 7.1 through 7.1.2</td>
<td>OT 1.1 and the OT 1.1.2 Updater</td>
</tr>
<tr>
<td>Mac OS 7.5.3 up to 7.6.x</td>
<td>OT 1.1.2 Updater (optional if OT 1.1.1 is installed)</td>
</tr>
<tr>
<td>Mac OS 8 or higher</td>
<td>None required</td>
</tr>
</tbody>
</table>
Installing Remote Access software

Depending on the Remote Access product you're installing, your product package includes:

- a CD-ROM disc containing the Remote Access software and the Installer program that you use to install the software on your computer
- two 1.44 megabyte (MB) floppy disks titled *Apple Remote Access Client Install Disk 1* and 2 (Remote Access Client only)
- four disks with Open Transport 1.1.2 Updater on them, in case this program is not already installed on your system

Follow the steps in this section to install the Remote Access software on your computer.

1. **Insert the CD into your CD-ROM drive and double-click the Installer icon to open the Installer.**

   If you're installing Apple Remote Access Client on a computer that does not have a CD-ROM drive, insert the *Apple Remote Access Client Install Disk 1* into your floppy disk drive and double-click the Installer.

2. **Click Continue in the Welcome screen that appears.**

   **IMPORTANT** If you have a previous version of Apple Remote Access Personal Server installed on your computer and you install Remote Access Client, your computer will no longer be able to answer calls, even if it was set up to answer calls previously. If you want to retain your answering capabilities, do not install Remote Access Client; rather, install the current version of Remote Access Personal Server software, which can answer as well as make calls to a remote server.

   If you are installing Remote Access Client and have a previous version of Remote Access Personal Server already installed, an alert box appears, warning you that your computer will no longer be able to answer calls. If you want to proceed, click Continue.
Select the disk onto which you want to install the Remote Access software and click Install.

If the Installer detects any open applications, it asks if it can close them before continuing the installation. Click Continue to proceed or Cancel to stop.

The Installer notifies you if Open Transport version 1.1.1 or later is not installed. Either switch to a disk that has Open Transport installed, or quit the Installer and install Open Transport on the disk.

*Note:* The Easy Install procedure does not install any modem scripts required for setting up an X.25 connection with Remote Access. If you require support for an X.25 connection, choose Custom Install from the pop-up menu of installation mode. Then select the X.25 Modem Scripts feature from the list of available installation options.

When the Installer has finished, a dialog box appears confirming that the installation was successful.

4 **Restart your computer.**

Installation is now complete. Depending on the software you installed, a Remote Access Client or Remote Access Personal Server folder appears in the disk directory. This folder contains the AppleScript files for the Remote Access application and a Read Me file with a list of modems supported by Remote Access. The following components are stored in your System Folder:

- a Remote Access control panel
- a DialAssist control panel
- a Modem control panel
- a Remote Access Control Strip module (for computers that support it)
- Open Transport Shared Library files (PowerPC or 68K) in the Extensions folder
- a Modem Scripts folder in the Extensions folder that contains scripts for the modems that Remote Access supports
- a Remote Access folder in the Preferences folder that stores configuration settings and entries in the Activity Log
Where to go from here

Now that you have installed Apple Remote Access, you need to configure the Modem, Remote Access, and other control panels with the information required to dial in to a remote server and establish a connection. For instructions, see Chapter 2.
After you’ve installed Apple Remote Access software on your computer, you need some additional information before you can use Apple Remote Access to dial in to a remote server. Ask your network administrator or Internet Service Provider for:

- The telephone number for the server you want to call.

- The name and password that gives you access to the remote network. Also, verify how your name is indicated on the server so that you can enter matching information when you call.

- The network protocols required to communicate with the remote server and any required protocol settings, such as an IP or domain name server address.
Basic steps for configuring a connection

The way you configure a Remote Access connection depends on the type of the network protocols that the remote server supports.

With Apple Remote Access 3.0, you can use one of two networking protocols for connecting to a remote server:

- ARAP (AppleTalk Remote Access Protocol), designed by Apple for remote connections to AppleTalk networks
- PPP (Point-to-Point Protocol), which supports multiple protocols through a serial connection, including AppleTalk and the TCP/IP protocol standard for the Internet

If you're not sure which protocols are running on the remote server, you can specify the protocols setting as Automatic. This selection instructs Remote Access to poll the remote server on the type of protocols it's running and to use the appropriate one in making the connection.

This table identifies the protocols supported by different types of servers. Your network administrator or service provider can provide you with specific set-up instructions, including which protocol to use.

<table>
<thead>
<tr>
<th>Type of server</th>
<th>Protocol(s) supported</th>
</tr>
</thead>
<tbody>
<tr>
<td>ARA Personal Server 2.x</td>
<td>ARAP</td>
</tr>
<tr>
<td>ARA Multiport Server 2.x</td>
<td>ARAP</td>
</tr>
<tr>
<td>ARA Personal Server 3.0</td>
<td>ARAP, PPP</td>
</tr>
<tr>
<td>PPP only server</td>
<td>PPP</td>
</tr>
<tr>
<td>Server for Internet Service Provider</td>
<td>PPP</td>
</tr>
<tr>
<td>Windows NT server</td>
<td>PPP</td>
</tr>
</tbody>
</table>

You must use the TCP/IP control panel to set up a TCP/IP connection configuration if

- you are using Remote Access to connect to an ISP providing access to the Internet
- you are connecting to an AppleTalk network, but also need to run applications that require a TCP/IP connection (for example, Telnet or a client/server database query application)
Use the TCP/IP control panel to specify one of two connection options:

- **AppleTalk (MacIP)**, a protocol configuration that provides IP connectivity by supporting the “tunneling” of IP across an AppleTalk network to an IP Gateway (DDP/IP Gateways are also MacIP servers.)

- **PPP (Point-to-Point Protocol)**, providing support for the TCP/IP protocol standard for the Internet
Configuration road map

Use this road map as a guide to configuring a connection to a remote server.

Setting up a Remote Access connection

Open the Modem Control Panel and set up your modem configuration.

Do I need to connect to an IP network (including the Internet)?

No

Do I need to connect to an AppleTalk network and use TCP/IP applications?

No

Open the Remote Access Control Panel and set up your Remote Access configuration.

Do I need to connect to an IP network (including the Internet)?

Yes

Open the TCP/IP Control Panel and set up your TCP/IP configuration.

Yes

Set up a configuration for connecting to one of the following networking protocols:

- PPP for an ISP or an IP-only server
- AppleTalk (Mac IP) for an AppleTalk server or an AT-only PPP server with access to IP services across an IP gateway.

Select the protocol running on the server:

- ARAP for an AppleTalk server
- PPP for a PPP server
- Automatic if you're not sure which protocol the server is running
Creating your connection configurations

Before you can connect to a remote server, you must first create the configurations that Remote Access uses to dial in and establish the connection.

You start your configurations in the Modem control panel. If you need to configure a PPP connection, you will also open the TCP/IP control panel. You complete your connection configurations in the Remote Access control panel.

Tip: When the Remote Access control panel is open, all the control panels and dialog boxes you need to set up your configuration are available through the RemoteAccess menu.

You need a separate configuration for each remote server you log in to. See “Managing Your Connection Configurations” in this chapter for more information on setting up and managing multiple configurations.

Setting up a modem configuration

Before you can use Apple Remote Access to connect to a remote server, you need to indicate the type of modem you are using to make the connection. The Read Me file in the Remote Access folder lists the modems that you can use with Remote Access. Appendix A tells you what to do if your modem isn’t listed.

Although you can use a modem capable of transmitting at least 9600 bits per second, a 28.8 kilobits-per-second or faster modem is recommended. For information on selecting a modem cable and connecting your modem to your computer, consult the manual that came with your modem.

Once you’ve properly connected the modem, follow the steps in this section to set up a configuration in the Modem control panel. Before starting, make sure you’ve already installed the Remote Access software according to the instructions in Chapter 1.

Note: If you are installing Apple Remote Access on a Macintosh PowerBook equipped with an Express modem, see Appendix C, “Using Remote Access With Macintosh PowerBook Computers.”
1 From the Apple menu, choose Control Panels, and then choose Modem.

The Modem control panel appears.

Note: If the Remote Access window is open, you can also open the Modem control panel by choosing Modem from the RemoteAccess menu.

2 Choose the port to which your modem is connected from the “Connect via” pop-up menu.

If you don’t know which port your modem is connected to, look at the back of your computer. The port where the modem is connected has an icon above it that looks like either a telephone receiver (modem port) or a printer (printer port).

If you have an internal modem that you want to use, choose Internal Modem.

3 Choose your modem type from the Modem pop-up menu.

If your modem doesn’t appear in the menu, see Appendix A.

4 Select On or Off for the modem speaker.

5 Select tone or pulse dialing.

6 Decide whether you want to ignore the dial tone when dialing.

If your phone has no dial tone or a nonstandard dial tone (common in hotels, for example), select Ignore dial tone to have Remote Access dial the telephone number without waiting for a dial tone. Otherwise, Remote Access cannot establish the connection.

7 Close the Modem window and click Save.

You have created your first configuration, called “Default.” For more information on working with configurations, see “Managing Your Connection Configurations,” later in this chapter.
If you are using Remote Access to connect to the Internet through an ISP, or if you are connecting to an AppleTalk network but also need to use applications that require a TCP/IP connection (for example, a Web browser or Internet e-mail client application), go to the next section and follow the instructions for setting up a TCP/IP connection configuration.

If you are using Remote Access to connect to an AppleTalk network and you do not need to use applications that require a TCP/IP connection, skip to the section “Setting Up a Remote Access Configuration” and follow the instructions for setting up a configuration.

Setting up a TCP/IP configuration

If you want Apple Remote Access to connect to a server on a TCP/IP network, you use the TCP/IP control panel to set up a PPP (Point-to-Point Protocol) connection configuration. PPP supports Internet Protocol (IP) and AppleTalk communications over a serial line.

Remote Access supports two types of TCP/IP configurations:

- **PPP**—for connections to a TCP/IP network, including the Internet (through dial-in access to an ISP)
- **AppleTalk (MacIP)**—for connections to an AppleTalk network that includes support for applications that use TCP/IP

If you're unsure about the type of configuration you need, your network administrator or Internet Service Provider can tell you which to choose. The most common selection, Using PPP Server, is described here. (This setting is also the default.)

Setting up a PPP configuration

Follow these instructions to set up a PPP configuration in the TCP/IP control panel.

1. **From the Apple menu, choose Control Panels, and then choose TCP/IP.**
   
The TCP/IP control panel appears.

   *Note:* If the Remote Access window is open, you can also open the TCP/IP control panel by choosing TCP/IP from the RemoteAccess menu.
2. If you are already using the existing settings to connect to a server, duplicate the configuration and rename it.

Choose Configurations from the File menu to view a list of available configurations.

![Configurations window]

*Note:* Your network administrator or ISP may have already prepared a configuration that you can import and activate, saving you time and reducing the possibility of configuration errors.

Each configuration that you set up applies to a specific server. If you want to connect to a different server, you need to set up a different configuration in the TCP/IP control panel. To avoid altering your existing configuration, create a duplicate of it and rename it. See “Managing Your Connection Configurations,” later in this chapter, for instructions. Otherwise, go to step 3.

*Tip:* Press ⌘-K to open the Configurations window.
3 In the TCP/IP control panel, choose PPP from the “Connect via” pop-up menu.

The window displays PPP options.

4 Choose Using PPP Server from the Configure pop-up menu.

*Note:* If your network administrator tells you to choose the Manually configure option, you also need to enter an IP address.

The remaining configuration options in this menu are rarely used. If your network administrator tells you to use one of them, you’ll need some or all of the following information: a subnet mask, a router address, name server addresses, or a domain name. Your network administrator should give this information to you.

5 Enter any name server addresses and starting domain name provided by your network administrator or Internet Service Provider.

6 Close the control panel and click Save.

The first time you save your TCP/IP settings, Open Transport stores them in the “Default” configuration. It’s a good idea to rename it something that identifies the remote server to which it applies.

Once your PPP configuration is complete, go to the section “Setting Up a Remote Access Configuration,” later in this chapter, and follow the instructions for creating a Remote Access configuration. Be sure to give it the same name as the TCP/IP configuration, because both configurations must be active when you connect to the server. For instructions on renaming, see “Managing Your Connection Configurations,” later in this chapter.
Setting up an AppleTalk (MacIP) configuration

If you are using Remote Access to connect to an AppleTalk network, but you also want to launch an application that requires a TCP/IP connection (for example, Telnet or a database query application), you can use the TCP/IP control panel to set up a MacIP configuration. (MacIP is an addition to the AppleTalk Protocol family that allows the transmission of TCP/IP packets across an AppleTalk network.)

*Note:* For access to TCP/IP services through a MacIP configuration, an IP gateway must be installed on the remote network.

1. **From the Apple menu, choose Control Panels, and then choose TCP/IP.**

   The TCP/IP control panel appears.

   *Note:* If the Remote Access window is open, you can also open the TCP/IP control panel by choosing TCP/IP from the RemoteAccess menu.

2. **If you are already using the existing settings to connect to a server, duplicate the configuration and rename it.**

   See “Managing Your Connection Configurations” for instructions. Otherwise, go to step 3.

3. **In the TCP/IP control panel, choose AppleTalk (MacIP) from the “Connect via” pop-up menu.**

   The window displays MacIP options.
4 Choose Using MacIP Server from the Configure pop-up menu.

*Note:* If your network administrator instructs you to choose the Using MacIP Manually configuration option, you also need to enter an IP address.

5 Enter any name server addresses and domain name provided by your network administrator or ISP.

*Note:* You will be unable to select a zone for the MacIP configuration until you dial in and connect to the server. You will need to reopen the TCP/IP control panel to make your selection after a connection is established.

6 Close the control panel and click Save.

Open Transport names your first configuration “Default.” It’s a good idea to rename it something that helps you remember the server to which it applies. Once your MacIP configuration is complete, go to the next section, “Setting Up a Remote Access Configuration,” and follow the instructions for creating a Remote Access configuration. Be sure to give it the same name as the MacIP configuration, because both configurations must be active when you connect to the server. For instructions on renaming, see “Managing Your Connection Configurations,” later in this chapter.

**Setting up a Remote Access configuration**

After setting up a modem configuration in the Modem control panel and, if necessary, a PPP or MacIP configuration in the TCP/IP control panel, you are ready to set up the Remote Access control panel.

The information that Remote Access needs to dial in and connect to a server is stored in a Remote Access configuration. You create and save a separate configuration for each server you call. The following steps describe how to create this configuration.
1 From the Apple menu, choose Control Panels, and then choose Remote Access.

Tip: If you have a Control Strip, press the Remote Access icon and choose Open Remote Access from the pop-up menu.

The Remote Access control panel appears.

2 If you are already using the existing settings to connect to a server, duplicate the configuration and rename it.

Each configuration that you set up applies to a specific server. If you want to connect to a different one, you must enter different information in the Remote Access control panel. To avoid altering your existing configuration, create a duplicate of it and rename it. See “Managing Your Connection Configurations,” later in this chapter, for instructions. Otherwise, go to step 3.
3 **Click Registered User or Guest.**

You can connect as a registered user if your network administrator has assigned you a user name and password. Otherwise, you can connect as a guest if the server permits guest access.

If you click Guest, skip to step 7.

4 **Type your user name in the Name text box and press Tab.**

Your user name must match the spelling that is registered with the server you want to call. Capitalization doesn’t matter for servers on an AppleTalk network, but it does matter for UNIX servers.

If you've specified an owner name in the Sharing Setup control panel, the owner name is already in the Name text box. However, you may need to change this name so it matches the name registered on the server.

5 **Type your password in the Password text box and press Tab.**

Type your password exactly as it is registered with the server you want to call. You must match uppercase and lowercase letters exactly. As you type, each character appears as a bullet (●) to prevent someone else from reading your password.

6 **To save your password in the configuration, click the “Save password” checkbox.**

If you save your password, you won’t need to enter it whenever you connect (unless your network administrator has set up the server so you must always enter a password). However, be aware that this compromises the security of the server you're calling, because anyone can then use your Remote Access configuration to connect.

7 **Type the phone number of the server you want to call in the Number text box.**

Enter the number as if you were dialing directly, including the area code and other numbers you might need, such as a number to get an outside line or a credit card number. You can use dashes in the telephone number to make it easier to read, but Remote Access doesn't require them.

If you need to slow down dialing at a certain point to ensure that the call connects, you can insert a comma in the phone number. Each comma causes the modem script to pause two seconds before dialing the rest of the phone number.
For example, if you’re at a hotel where you must dial 9 to get an outside line, and you want to call your server at work using a credit card, you might type

9,0 818-555-1234, credit card number

Note: The zero (0) is needed to identify the credit card call.

**IMPORTANT** To automate the dialing process, you may want to use the DialAssist option, discussed in Chapter 3.

8 Click Options at the bottom of the control panel.
Go to the next section, “Setting Remote Access Options.”

**Setting Remote Access options**

The Remote Access window contains an Options button that you can click to specify Remote Access preferences for network protocol, redialing choices, and connection reminders. You may have additional options if your network administrator has installed special software in your Extensions folder. See the section “ARAP Protocol Options” later in this chapter for more information.

**Viewing Remote Access options**

1 Open the Remote Access control panel and choose Configurations from the File menu.
If you have a Control Strip, press the Remote Access icon to display the pop-up menu and choose a configuration. A black dot identifies the configuration currently selected. Then choose Open Remote Access. Go to step 3.

2 Select the the configuration for which you want to set preferences and click Make Active, or create a new configuration.
The first configuration you create is called “Default.” For instructions on creating another configuration, see “Managing Your Connection Configurations,” later in this chapter.
3 Click Options in the Remote Access window.

The Options dialog box appears. It contains three tabbed sections of Remote Access options.

To view a section, click its tab.

Setting protocol options

In the Protocol section, you can choose the type of networking protocol you want Remote Access to use to connect to the remote server. The three protocols are ARAP, PPP, and AUTOMATIC.

IMPORTANT The protocol options you choose through the Remote Access control panel apply only to connections that you initiate with Remote Access Client. When setting up Remote Access Personal Server for dial-in access, you do not need to specify networking protocols. The remote user selects the networking protocol (ARAP or PPP) for the connection. When the client attempts to connect, Remote Access Personal Server detects the protocol type and automatically negotiates a connection. For more information on setting up Remote Access Personal Server, see Chapter 4.

1 To view protocol options, click the Protocol tab.

The Options window displays the contents of the Protocol section.
From the “Use protocol” pop-up menu, choose the protocol required by the remote server.

Depending on the protocol selected, the Options window may display additional options available for that protocol.

If you are unsure about the type of protocol required, choose AUTOMATIC. AUTOMATIC determines the protocol for you.

Select the connection options, if any, that you want to use for the protocol.

The following three sections describe the settings available for the ARAP and PPP protocols.

Click OK to return to the Remote Access configuration window or click the Connection tab to set connection options.

The preferences you specified are now in effect. You are ready for the section, “Setting Connection Options,” later in this chapter.

ARAP protocol options

If you choose ARAP (AppleTalk Remote Access Protocol), the window looks like this:

Be sure that AppleTalk is set to Active in the Chooser. Choose the Remote Only option if you do not require access to your local network during the remote connection. See “Using the Remote Only Option” later in this chapter for a complete explanation.
If you select the ARAP protocol option and your Modem Scripts folder contains an X.25 modem script that was installed with the ARA Installer's custom installation, you can make a connection through an X.25 service.

The network provider names that appear in the Network pop-up menu correspond to network provider scripts installed in your Modem Scripts folder.

The text boxes that appear on the Protocol section are determined by the network provider you choose.

You may have to enter the X.25 network address of your remote server, supply a network user ID or the name of your closed user group.
PPP protocol options

If you choose PPP, the window looks like this:

![PPP protocol options window](image)

With a PPP connection, you have the option of making a manual connection to the PPP server or an automatic connection.

**Connect automatically:** Select this option to have a PPP connection opened automatically when you launch an application that requires a connection to a TCP/IP network (for example, a World Wide Web browser or an Internet e-mail application). Otherwise, you must open Remote Access and start up PPP before you launch your application.

You can also automate this process using a connect script.

**Connect to a command-line host:** Click this checkbox to connect to a command-line host—a remote server that requires you to log in through a terminal window. Typically, you must provide a valid account name and password before the remote server permits access. You can also automate this process using a connect script.

*Use terminal window:* Select this option to open a terminal window when Remote Access is establishing the connection. Use the window to enter responses to a command-line host's request for user name, password, and any other information the host requires to validate a connection.
For detailed instructions on using a terminal window to connect to a command-line host, see the section “Connecting to a Command-Line Host” in Chapter 3.

*Use connect script:* Select this option to use a connect script—a set of pretyped responses to a command-line host's request for user name, password, and any other information the host requires to validate a connection. By using a connect script you can connect to a command-line host without typing responses in the terminal window.

When you select this option, you must use the Import Script button to import the script you want to use. The name of the imported file appears next to “Use connect script.” For detailed instructions on importing a script, see the section “Connecting to a Command-Line Host” in Chapter 3.

After importing a connection script file, you can use the Export Script button to save its contents in a new location under a new file name.

The options “Allow error correction and compression in modem” and “Use TCP header compression” are selected by default to improve the speed of transmission and the accuracy of the data transmitted. Leave them selected unless you have trouble making or maintaining a connection.
Setting connection options

To view connection options, click the Connection tab. The Options window displays the contents of the Connection section.

Select these options to specify verbose logging or set up connection reminders.

1 If you want the Activity Log to record more detailed information about your connections, select “Use verbose logging.”

*Note:* The information stored by verbose logging may be helpful to a network administrator, ISP support person, or anyone else troubleshooting any connection problems you’re experiencing.

For more information, see “Using the Activity Log” in Chapter 3.

2 If you want Remote Access to remind you of your connection, select one or more reminder options.

If you click the “Flash icon in menu bar while connected” checkbox, the Remote Access icon flashes in the Apple menu after you have connected.

If you click the “Prompt every 5 minutes to maintain connection” checkbox, a text box appears in which you can type a number that tells Remote Access how often, in minutes, to display a message asking if you want to continue your connection. (The default is 5 minutes.) If you click OK, your work is not interrupted. If you do not respond within one minute, Remote Access disconnects you.
If you click the “Disconnect if idle for 10 minutes” checkbox, a text box appears in which you can type a number indicating the number of minutes a connection can remain idle (no activity) before Remote Access disconnects it.

3 Click OK to return to the Remote Access configuration window.

The preferences you specified are now in effect.

4 If you have finished selecting options, close the Remote Access control panel and click Save.

If you created a corresponding TCP/IP configuration, be sure to give this configuration the same name so that you can match the two when you make a connection. Both configurations must be active for the connection to work. See “Managing Your Connection Configurations,” later in this chapter, for instructions on renaming a configuration.

**Setting redial options**

Use the Redialing section of the Options window to specify whether you want Remote Access to redial a busy telephone number when calling a server or to dial an alternate phone number if the main phone number is busy.

Follow these steps to choose the redialing option:

1 If Redialing is not already selected, display it by clicking the Redialing tab.

The Redialing options appear.
2 Choose one of the redialing options from the Redial pop-up menu.

You can choose to redial the main phone number that you typed in the configuration or both the main number and an alternate number.

3 Type the number of times you want Remote Access to redial the telephone number (or numbers) and indicate the amount of time you want to elapse between redials (in seconds).

You can specify that the number (or numbers) be redialed up to 1000 times. Set the “Time between retries” number to five seconds or greater to give your modem sufficient time to reset; otherwise, the serial port may be busy and unavailable for redialing. The maximum time between retries is 1000 seconds.

Note: Redialing only occurs if the connection fails because the number dialed is busy. If the connection attempt fails for any other reason, Remote Access stops redialing so that you can correct any problems.

4 If you want Remote Access to redial an alternate phone number, type the number in the Alternate number text box.

Follow the same conventions you used for the main telephone number. (For more details, see the section “Setting Up a Remote Access Configuration” earlier in this chapter.)

Remote Access dials the main number first. If that number is busy, Remote Access dials the alternate number, and then switches between the main number and alternate number until a connection is made or until the number of redials you have specified is reached.
5 Click OK.

The Remote Access configuration window reappears, and the preferences you specified are now in effect.

6 If you have finished selecting options, close the Remote Access control panel and click Save.

If you created a corresponding TCP/IP configuration, be sure to give this configuration the same name so that you can match the two when you make a connection. Both configurations must be active for the connection to work. See “Managing Your Connection Configurations,” later in this chapter, for instructions on renaming a configuration.

Using the Security option (ARAP only)

If you are connecting to a Remote Access–compatible server running non-Apple security software, your network administrator may install additional software in your Extensions folder that you must configure in order to gain access to your server. In this case, a Security tab appears in the Options dialog box. You select this tab to indicate your security type and related information.
Follow these steps to specify security information:

1. **Open a Remote Access configuration and click Options.**
   For help opening a configuration, see “Activating a Configuration,” later in this chapter.

2. **Click the Security tab.**
   The Security section appears.

3. **Choose the appropriate security module from the “Security type” pop-up menu.**
   Security software is installed and maintained by your network administrator. Contact your administrator if you need information about what security software to select.

4. **Click the Configure button if it is available.**
   Select the options presented by your security module.

5. **Click OK.**

6. **If you have finished selecting options, close the Remote Access control panel and click Save.**
   If you created a corresponding TCP/IP configuration, be sure to give this configuration the same name so that you can match the two when you make a connection. Both configurations must be active for the connection to work. See “Managing Your Connection Configurations,” later in this chapter, for instructions on renaming a configuration.
Switching connection types during an active connection

As a general rule, you should not switch from an AppleTalk or IP connection while a connection is active.

If your computer is currently connected to a remote network and you switch connection types in the AppleTalk control panel, the effect on your active connection depends on the type of the connection currently established:

- If you change the type of network connection during an active ARAP connection, the connection is closed and AppleTalk services are dropped.
- If you change the type of network connection during an active PPP connection, the connection is maintained but only IP services remain available. Any AppleTalk services made available through the connection are dropped.

If you lose your connection upon switching connection types, you can always reconnect.

Where to go from here

Once you have followed all the steps to configure Remote Access for a connection, you are ready to connect to a remote server. See Chapter 3 for instructions. To set up your computer for dial-in access, see Chapter 4.
Managing your connection configurations

The Modem, TCP/IP and Remote Access control panels each provide a Configurations window that you can use to manage your connection configurations. To display the Configurations window, open the appropriate control panel and choose Configurations from the File menu (or press ⌘-K). The Configurations window shows the available configurations and provides controls for managing them.

![Configurations window](image)

**IMPORTANT** The first configuration you create with Remote Access is automatically stored as the default configuration.

Creating a configuration

To create a configuration, begin by making a copy of an existing configuration. Follow these instructions.

1. **Open the Modem, TCP/IP, or Remote Access control panel and choose Configurations from the File menu.**

2. **In the Configurations dialog box, select a configuration and click Duplicate.**
   The Duplicate Configurations dialog box appears, prompting you for a new name for the duplicate configuration.

3. **Rename the configuration and click OK.**
   The list of configurations in the Configurations dialog box now includes the renamed duplicate configuration.
4 Select the duplicate configuration, if it’s not already selected, and click Make Active.

The control panel now displays the name of the duplicate configuration in the title bar.

5 Replace the existing setup information and settings with the information and settings you want for the new configuration.

6 Save the configuration when you close the control panel.

**Activating a configuration**

You can create as many configurations as you want and activate each one as required.

To activate a configuration:

1 Open the Modem, TCP/IP, or Remote Access control panel and choose Configurations from the File menu.

2 Select a name in the Configurations window and click Make Active.

The Configurations window closes and the Remote Access control panel displays the connection information associated with the active configuration.

*Tip:* If your computer has a Control Strip, you can bypass the Remote Access control panel by pressing the Remote Access icon and choosing a configuration from the list displayed in the pop-up menu.

**Saving a configuration**

You can make changes to a Modem, TCP/IP, or Remote Access configuration by making it active and editing any of the information in it. To save your changes, choose Close, Configurations, or Quit from the File menu, or click the close box on the control panel. When a message asks you to save your changes, click Save. There is no other way to save a configuration. The File menu for the control panel does not have a Save or Save As command.
Renaming a configuration

After creating a Modem, TCP/IP, or Remote Access configuration, you can provide it with a descriptive name that indicates its purpose.

To rename a configuration, choose Configurations from the File menu, select the name of the configuration you want to change, and click Rename. Remote Access displays a dialog box asking you to enter a new name. Type the new configuration name and click OK.

Exporting a configuration

By exporting configurations to files that can be distributed to remote users, network administrators and other support personnel can ensure that connections are properly configured.

To export a configuration to a file that can be distributed to others, follow these steps:

1. Open the Modem, TCP/IP, or Remote Access control panel and choose Configurations from the File menu.
2. Select a name in the Configurations window.
3. Click Export to display the “Export as” dialog box.
4. Change the name of the file in the “Export as” field, if desired, and open a folder in which you want to save the file.
5. Click Save.

Note: Only individual configurations can be exported to files. If you wish to export a set of configurations for a connection, you must export each configuration as a separate file.
**Importing a configuration**

Instead of creating configurations by entering values and selecting options, you can import a configuration created by someone else or a configuration stored in a connection file created with Apple Remote Access 2.x.

To import a configuration, follow these steps:

1. **Open the Modem, TCP/IP, or Remote Access control panel and choose Configurations from the File menu.**
2. **Click Import.**
   - The Directory dialog box appears.
3. **Find the file you want to import, select its name, and click Open.**
   - The file name appears in the Configuration window.

*Note:* If you import a configuration with locked settings, the settings remain password-protected when activated. You will be unable to modify the locked settings without the password created in the control panel’s Administrator mode. For more information on user modes and locking settings, see the section “Selecting a User Mode,” later in this chapter.

**Deleting a configuration**

As configurations become outdated, you can remove them from the configuration list. To remove a configuration, make it inactive. Then select it in the Configurations window and click Delete. Remote Access displays a dialog box asking you to confirm the deletion.
Selecting a user mode

The Modem, TCP/IP, and Remote Access control panels provide three modes, or levels of access to features: Basic, Advanced, and Administration. Each successive level offers additional control over Remote Access connections.

By default, each Open Transport control panel starts in Basic mode. After opening the Modem, TCP/IP, or Remote Access control panel, you can change the mode by choosing User Mode from the Edit menu and selecting another mode.

Select a user mode in the dialog box and click OK to change to the selected mode.

When Advanced user mode is active, the Remote Access configuration window displays a checkbox for activating the settings stored in the DialAssist control panel.
When Administration user mode is selected, you can specify a password for locking and unlocking connection parameters, including the login name, password and dial-in number. When Administration mode is active, the control panels displays lock buttons that you can use to lock or unlock connection settings.

Lock the permissions setting or dial-in number by clicking the lock button that appears next to the setting. The button icon changes to a closed lock, indicating that the setting cannot be changed until it is unlocked.

When a configuration setting is locked, you cannot unlock it without selecting Administration mode in the User Mode dialog box. If you have assigned a password, you must also enter it.

*Note:* When you export a configuration with locked settings, the settings remain password-protected when the configuration file is imported as a new configuration. This allows you to distribute configurations that safeguard settings that should remain unchanged, while allowing remote users to modify parameters that can vary between users or locations—for example, the dial-in access phone number.
Using the Remote Only option

When you set up a Remote Access configuration to connect to an AppleTalk network via ARAP or PPP, you can close your connection to the local network while your computer is connected to a remote network.

There are three reasons for selecting the Remote Only option:

- To turn off access to your local AppleTalk network (LocalTalk, EtherTalk, or TokenTalk), so you see only the remote network when you make a Remote Access connection.

  Sometimes you can’t locate a service on the remote network because a service on your local network has the same address. By selecting Remote Only, you shut off access to the local network, eliminating the possibility of duplicate addresses and making all services on the remote network accessible.

- To turn off LocalTalk (which uses the printer port on your computer) and free the serial port for other devices.

- To use Remote Access on a computer with only one serial port.

Computers with a single serial port include the Macintosh PowerBook 190, 5300, 1400, 2400, and 3400 series and the Macintosh PowerBook Duo 230, 280, and 2300 series. If you are using an external modem on a PowerBook that doesn’t have an Ethernet port (either built-in or supplied by a PC Card), you need to specify Remote Only because there is no available serial port to connect to the local network.
1 Make sure the correct Remote Access configuration is open.

2 From the RemoteAccess menu, choose AppleTalk.

   The AppleTalk control panel opens, displaying the current AppleTalk setting.

3 Choose Remote Only from the “Connect via” pop-up menu and click the close box.

4 Click Save.
Once you have set up your Modem, Remote Access, and TCP/IP configurations (and AppleTalk for the Remote Only option), as described in Chapter 2, you are ready to connect to a remote server. Depending on the protocol options you selected in your Remote Access configuration, you can log in during a connection by having Remote Access

- send your name and password to the server for authentication
- display a terminal window so that you can log in manually
- send a connection script with log-in information to the server

You don't need the last two options unless you are logging in to a command-line host.

You can also dial out manually, or connect and disconnect by using an AppleScript script. See Appendix D for more information.
Connecting to a server

Before connecting to a server, you must make sure that the Modem, TCP/IP, Remote Access, and AppleTalk (for Remote Only) configurations are correct and active. Follow these steps to ensure a smooth connection to a remote server.

Configuring the modem

1. From the Apple menu, choose Control Panels, and then choose Modem.
   The Modem control panel opens, displaying the active modem configuration.

2. If the Modem control panel displays the correct configuration, go to the next section, “Configuring TCP/IP.” If not, choose Configurations from the File menu, select the correct configuration, and click Make Active.
   You can close the Modem control panel or leave it open.

3. If you are connecting to an ISP or need to use TCP/IP applications while connected to an AppleTalk network, go to the next section, “Configuring TCP/IP.” Otherwise, skip to the section “Configuring Remote Access.”

Configuring TCP/IP

You need to create a TCP/IP configuration only if you need to use a TCP/IP application such as a Web browser, a terminal emulator, or database query tool.

You can configure TCP/IP for a PPP connection to a TCP/IP network, including the Internet (through dial-in access to an ISP) or for a MacIP connection to an AppleTalk network with support for applications that use TCP/IP.

If you don't need to use any TCP/IP applications over a remote connection, skip to the next section—you do not require a TCP/IP configuration to establish a connection.

1. From the Apple menu, choose Control Panels, and then choose TCP/IP.
   The TCP/IP control panel opens, displaying the active TCP/IP configuration.
2 If the TCP/IP control panel displays the correct configuration, go to the next section, “Configuring Remote Access.” If not, choose Configurations from the File menu, select the correct configuration, and click Make Active.

After activating a configuration, you can close the TCP/IP control panel or leave it open.

**IMPORTANT** For some MacIP configurations, you may need to return to the TCP/IP control panel and select an AppleTalk zone for the MacIP server after you’ve established a connection through the Remote Access control panel.

### Configuring Remote Access

1. From the Apple menu, choose Control Panels, and then choose Remote Access.
2. If the Remote Access control panel displays the correct configuration, go to the next section. If not, choose Configurations from the File menu, select the correct configuration, and click Make Active.

   *Tip:* If there is a Control Strip on your desktop, press the Remote Access icon to display the pop-up menu and choose a configuration. Then choose Open Remote Access from the pop-up menu.

### Connecting to remote services

- **In the Remote Access control panel, click the Connect button.**

Remote Access calls the server and tries to connect to it. Information displayed in the Status area shows you the progress of your connection.

If you want to cancel the connection attempt before the connection is completed, click Cancel.

If a terminal window appears, you must enter your registered name and password to connect to the server. See the section “Connecting to a Command-Line Host.”

If you connect as a registered user, the server verifies your name and password before the connection is established.
Note: If you attempt a connection with an incorrect password, an error message, such as Authentication Failed, appears. Depending on the type of server, you may be able to retype your password and try again. If you are allowed to retype a password, your network administrator has the option of setting a limit on the number of times you can try to connect. For instance, if the limit is set at three and you mistype your password three consecutive times, the server may disconnect you, forcing you to reconnect and log in again. Or the server may revoke your log-in privileges. In this case, you'll need to check with your network administrator to have your privileges reinstated.

![Remote Access Configuration](image)

Note: If the server has callback turned on, you are temporarily disconnected while the server attempts to call you back. Your phone will ring, the modem will answer the call, and the connection will be established.

**IMPORTANT** If you try to connect before setting up your modem, a message informs you that the connection is not possible. Click the Setup button and follow the instructions in Chapter 2 to set up your modem. Then try connecting again.
Monitoring the status of your connection

During an active connection, the Status area in the Remote Access control panel indicates the connection speed, the time connected, and the time remaining for your connection. The time limit is set by the network administrator of the server you've called. If you have no time limit for your connection, the word *Unlimited* indicates the time remaining.

The Status area also shows the name of the server to which you are connected or the IP address of the server's host. Two indicator lights show the movement of data packets between your computer and the remote server.

If you have a Control Strip, you can monitor the time connected or the connection time remaining in the Remote Access Control Strip module. Follow these steps to display the connection status in the Control Strip:

1. **In the Control Strip, press the Remote Access icon to display the pop-up menu and choose Status Display.**
2. **In the Status Display dialog box, select an option.**

   - *Icon only.* The Remote Access icon flashes on the left end of the menu bar during the connection.
   - *Time connected.* The Remote Access module indicates how long you have been connected.
   - *Time remaining.* The Remote Access module indicates the time you have left before being disconnected by the server.
3 Click OK.

Except in the case of “Icon only,” the Remote Access module expands to display the status option you selected.

Connecting to a command-line host

A command-line host is a remote server that requires you to log in through a terminal window. Typically, you must provide a valid account name and password. You can also automate this process using a connect script.

If you haven't selected the “Use terminal window” option in the Protocol section of your Remote Access configuration, you must do so before connecting. See “Setting Protocol Options” in Chapter 2 for instructions.

Using a terminal window

Follow these steps to connect to a command-line host using a terminal window:

1 Choose the appropriate Modem, TCP/IP, and Remote Access configurations.

See the earlier section “Connecting to a Server” for instructions.
2  In the Remote Access control panel, click the Connect button.

Remote Access calls the server and tries to connect to it. Information displayed in the Status area shows you the progress of your connection. After connecting, Remote Access displays a terminal window.

3  Enter the information requested, pressing Return at the end of each response.

If you don't respond to the server prompt in the terminal window soon enough, the server will disconnect you. The server determines the time you have to respond. When the time has elapsed, the server's modem sends hangup strings such as ATH or +++.

When the connection is established, Remote Access should close the window. If it remains open, click Continue to close it.

**Setting terminal window options**

You can choose to close the terminal window or keep it open when you connect to the host.

1  In the terminal window, click Settings.

The PPP Terminal Settings dialog box appears.

2  Deselect the “Close Terminal when PPP is started” option to keep the terminal window open after you log in.

Leave this option selected to have Remote Access close the terminal window once the connection to the host is established.

3  Click OK to save your changes.
Importing a connect script

A connect script is a set of responses to a command-line host’s request for user name, password, and any other information the host requires. With a connect script you can connect to a command-line host without typing responses in the terminal window.

Follow these instructions to import a connect script:

1 **Click Options in the Remote Access configuration window.**

The Options dialog box appears. It contains three tabbed sections of Remote Access options.

2 **To view protocol options, click the Protocol tab.**

The Options window displays the contents of the Protocol section.

3 **From the Use protocol pop-up menu, choose PPP.**

4 **Click the “Connect to a command-line host” checkbox.**

5 **Click the “Use connect script” button.**

6 **Click Import Script.**

An Open dialog box appears.

7 **Locate the connect script you want to use, then select it and click Open.**

Once the connect script is loaded, the name of the file appears next to the Use connect script button.

Creating a connect script

Remote Access allows you to create your own connect scripts by recording the sequence of the command-line host’s prompts and your responses required to validate the connection.

Follow these instructions to create and save a connect script:

1 **Open a terminal window, as described in the previous section “Using a Terminal Window.”**

2 **Type the information requested by the command-line prompts.**

3 **Before completing your login, click Settings at the bottom of the terminal window.**
4 In the PPP Terminal Settings dialog box, select “Prompt to save Connect Script on close.”

5 If you want the terminal window to close as soon as you finish logging in, select “Close Terminal when PPP is started.”

6 Click OK.

If you did not choose to close the terminal window, click the Continue button in the PPP Terminal window to close it. A Save As dialog box appears.

7 **Name the script, open a folder to save it in, and click Save.**

*Importing a connect script* Your system administrator or Internet service provider may export a connect script for your use. For instructions on importing the script, see “Importing a Connect Script.”

---

**Dialing manually**

There may be times when you want to dial manually rather than have Remote Access place the call. For example, you may want to make an operator-assisted call. You must have a telephone attached to your modem in order to place a manual call. To dial manually, follow these steps:

1 **Open Remote Access and activate the appropriate configuration.**

To dial manually, you must specify your user name and password. You do not need to enter the phone number of the server you’re calling.

2 **Choose Dial Manually from the Remote Access menu.**

A dialog box similar to this one appears:

![Pick up the phone & dial 5551212. When the phone rings, click OK then hang up.](image)

3 **Dial the server’s telephone number or have an operator place the call.**
4 When the phone answers, click OK and hang up the phone.

*Note:* Different modems connect in different ways. You may need to experiment with pressing the Connect button just before or just after you hear the remote modem answer the phone.

You are now connected to the remote server.

**Using DialAssist**

DialAssist is a Remote Access feature that masks the complexity of dealing with the worldwide telephone system. It is especially useful to Remote Access users who travel extensively. After you specify some basic information in the DialAssist setup window, DialAssist automatically provides portions of a phone number for you—including numbers to obtain an outside line, long-distance access numbers, international access codes, country codes, and credit card or calling card numbers. This means that you don't have to enter these numbers manually each time you make a call.

The numbers provided by DialAssist appear in a Preview field in the Remote Access configuration, so you can check the entire phone number before you actually connect.

For more information on setting up and using DialAssist, open Remote Access Guide and follow the on-screen instructions for using DialAssist. To display Remote Access Guide, click the question mark icon that appears in the lower-left corner of Remote Access windows, or choose Remote Access Guide from the Help menu when the Remote Access control panel is open or while you are connected to a remote server with Remote Access.

Follow these steps to set up and use DialAssist:

1. **Open the Remote Access control panel and activate the configuration for which you want to set up DialAssist.**

2. **Click the Use DialAssist checkbox.**
3 Choose DialAssist from the RemoteAccess menu.

The DialAssist setup window appears.

*Note:* Another way to open the DialAssist setup window is to choose Control Panels from the Apple menu and then choose DialAssist.

4 Type your current city code or area code in the text box labeled Area Code.

By comparing the number you enter here to the area code of the number you're dialing, DialAssist can determine whether to append a long-distance access number to the phone number.

*Note:* If you are calling within a country with no city or area codes, and you encounter problems using DialAssist, try entering a space in the Area Code box in your Remote Access configuration.

5 Choose the country in which you are currently located from the Country pop-up menu.

By comparing your current country to the country you're calling, DialAssist can determine whether to append an international access code (the code for access out of your current country) and country code (the code for the country you're calling) to the phone number. DialAssist automatically adds these codes to the phone number, if necessary.
If your current country does not appear in the pop-up menu, follow these steps to add the country and associated country code and international access code to the menu and to choose the new country:

a. Click the Country button in the Edit portion of the DialAssist setup window. The Countries dialog box appears.

![Countries dialog box]

b. Click the Add button. The following dialog box appears:

![Add country dialog box]

c. Type the country name in the Country text box, type the country code in the Country Code text box, and type the country's international access code in the Access Out text box.

You can obtain the country code and access code by looking in the phone book or by calling the international operator.

d. Click OK.

You are returned to the Countries dialog box. The country, country code, and international access code are added to the list and are highlighted.

e. In the Countries dialog box, click OK.

You are returned to the DialAssist setup window.
f. Choose the country from the Country pop-up menu in the DialAssist setup window.

*Note:* You can edit any of the entries in the Countries dialog box by selecting the entry and clicking the Edit button. Similarly, you can delete any of the entries using the Delete button.

6 If you need to add a prefix to your telephone number, for example, to get an outside line, choose this number from the Prefix pop-up menu in the DialAssist setup window.

If the prefix you need does not appear in the pop-up menu, follow these steps to add a new prefix to the menu and to choose the new prefix:

a. Click the Prefix button in the Edit portion of the DialAssist setup window. The Prefixes dialog box appears.
b. Click the Add button. The following dialog box appears:

```
Label:          
Number:         

[Cancel]    [OK]
```

c. Type a label for the prefix (such as “work”) in the Label text box; then type the prefix followed by a comma in the Number text box.

d. Click OK.

The Prefixes dialog box appears again. The prefix has been added to the list and is highlighted.

e. In the Prefixes dialog box, click OK.

You are returned to the DialAssist setup window.

f. Choose the prefix from the Prefix pop-up menu in the DialAssist setup window.

Note: You can edit any of the entries in the Prefixes dialog box by selecting the entry and clicking the Edit button. Similarly, you can delete any of the entries using the Delete button.

7 If you’re making a long-distance call, choose your long-distance carrier from the Long Distance Access pop-up menu in the DialAssist setup window.
DialAssist automatically provides the long-distance access number associated with your carrier. (This number will appear in the Preview field of the Remote Access configuration.) If your long-distance carrier does not appear in the pop-up menu, follow these steps to add it to the menu and to choose the new carrier:

a. Click the Long Distance button in the Edit portion of the DialAssist setup window. The Long Distance Access dialog box appears.

b. Click the Add button. The following dialog box appears:

c. Type a label for your long-distance carrier in the Label text box; then type the long-distance access number in the Number text box. (You can obtain the access number from your long-distance carrier.)

d. Click OK.

You are returned to the Long Distance Access dialog box. The long-distance carrier and access number have been added to the list and are highlighted.

e. In the Long Distance Access dialog box, click OK.

You are returned to the DialAssist setup window.

f. Choose the long-distance carrier from the Long Distance Access pop-up menu in the DialAssist setup window.
Note: You can edit any of the entries in the Long Distance Access dialog box by selecting the entry and clicking the Edit button. Similarly, you can delete any of the entries using the Delete button.

8. If you need to add a suffix to your telephone number, such as a credit card or a calling card number, click the Suffix button in the Edit portion of the DialAssist setup window.

The Suffixes dialog box appears, as shown. The entries in this dialog box are simply placeholders; you can edit these placeholders or add a new entry. The following steps describe how to edit the placeholders to enter your own credit card or calling card number or another suffix.
a. With the label My Credit Card highlighted, click the Edit button.

The following dialog box appears:

<table>
<thead>
<tr>
<th>Label:</th>
<th>My Credit Card</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number:</td>
<td>*****************</td>
</tr>
</tbody>
</table>

b. Type a label for your suffix (such as “MCI credit card”) in the Label text box; then type the numbers for your suffix in the Number text box.

c. Click OK.

The Suffixes dialog box appears again. The suffix you edited is highlighted. For security, each number you entered in the Number text box appears as a bullet (•).

d. In the Suffixes dialog box, click OK.

You are returned to the DialAssist setup window.

e. Choose the suffix from the Suffix pop-up menu in the DialAssist setup window.

*Note:* You can add a new entry to the Suffixes dialog box by using the Add button. You can delete any of the entries by selecting the entry and using the Delete button.
9 Once you've specified all the appropriate setup information in the DialAssist setup window, reactivate the Remote Access window by clicking in it.

The window now contains a text box for City/Area Code and a Country pop-up menu for choosing the country you want to connect to, as shown in the following picture. In addition, the Preview field of the Remote Access configuration reflects the settings you chose in the DialAssist setup window. For security, the suffix information (which may contain your credit card or calling card number) is identified by label only, rather than by the actual number.

![Remote Access window](image.png)

10 In the City/Area Code text box, type the city code or area code of the server you're calling.

If the city or area code you're calling is different from your current city or area code, DialAssist adds this city or area code to the telephone number. In addition, DialAssist adds your long-distance access number to the phone number. The city or area code and long-distance access number appear in the Preview field of the Remote Access configuration.

*Note:* If you already have a city code or area code in the Number text box, make sure you delete it and enter it in the City/Area Code text box.
11 From the Country pop-up menu, choose the country you’re calling.

If you are calling another country, DialAssist automatically adds the appropriate international access code and country code to the phone number. These codes appear in the Preview field of the Remote Access configuration window as shown in the following picture.

If the country you're calling does not appear in the pop-up menu, follow these steps to add the country (and its associated country code and international access code) to the pop-up menu and to choose the country:


12 To connect to the server, click the Connect button in the Remote Access window.

Remote Access dials the telephone number as it appears in the Preview field of the Remote Access configuration.
Note: The Preview field of the Remote Access configuration cannot be edited. If you need to change any part of the telephone number that appears there, go back to the DialAssist setup window (click the Setup button in the Remote Access configuration or choose DialAssist from the Setup menu) or change the appropriate information in the Remote Access configuration.

Selecting remote network services

With Remote Access, you can simultaneously use the services of your local AppleTalk network as well as the services of the server you've called. Once you've established a connection to a remote AppleTalk network, you can select network services in the Chooser window or use other network products, such as electronic mail, following the same steps you would take to use the services on your local network.

Note: If you want to exchange files with a remote computer after calling a server, make sure that file sharing is turned on for the remote computer. For more information about file sharing, talk to your network administrator or refer to your Mac OS documentation.

As an example, the following discussion illustrates how to print on a LaserWriter that's on a remote AppleTalk network while you're still connected to your home LaserWriter. Let's say you have not yet used Remote Access to connect. The list of local services available to you, which appears in the Chooser, would look something like this:
Once you’ve used Remote Access to call the server and established a connection with the remote AppleTalk network, the services available on the remote network will also appear in the Chooser, as shown in the following figure. You can select the zone (if there are zones) and services you want on the remote network.

![Chooser screen showing AppleShare and LaserWriter services](image)

**Connecting automatically to a volume on a remote AppleTalk server**

Once you’ve created a Remote Access configuration, you can connect automatically to a shared volume on an AppleTalk server by creating an alias. (For a detailed discussion of aliases, refer to your Mac OS documentation.)

If you create an alias for a shared folder or volume while you are connected to a remote AppleTalk network, the alias also stores the information it requires to connect to the remote service, including protocol settings and dialing information. If you open the alias later and Remote Access is unable to locate the folder or volume through the existing connection, it will attempt to reconnect using the dial-in information stored in the alias.

*Note:* You will have to reenter your password to reconnect and mount a server volume opened with an alias.

IMPORTANT  When you create aliases for connecting to remote services, you are taking a snapshot of all the configuration settings used to make the connection. If you reconfigure your settings, you must also create a new alias that stores the correct configuration settings.

Changing your Remote Access password (ARAP only)

If you are connected to a server using the Apple Remote Access Protocol (ARAP), you can change your Remote Access password as described in the following steps. (Click Options in the Remote Access control panel and then click the Protocol tab to check the protocol setting.)

Note: If you are connected to a server using PPP, contact your network administrator for information on changing your access password.

Note: Contact your network administrator to find out if AppleShare (or Macintosh file sharing) is running on the same computer as the Remote Access server. AppleShare and Remote Access share information about registered users. If you change your password via Remote Access, your AppleShare password changes also.

1  Connect to a remote server using the procedures described in the section “Connecting to a Server,” earlier in this chapter.

Leave the Remote Access configuration window open.

2  Choose Change Password from the RemoteAccess menu.

The Change Password dialog box appears.

![Change Password dialog box](image)
3 Type your current password in the text box labeled “Old password.”
A bullet (•) appears for each character you type.

4 Type a new password in the text box labeled “New password.”
A bullet (•) appears for each character you type. Use a password that will not be easily guessed by someone else.

5 In the text box labeled “Retype new password,” type the new password again to verify it; then click OK.
A dialog box appears, reminding you to update any configurations that will need to use the same password.

6 Click OK.
Your password has been changed.

Making efficient connections

Remember that when you use Remote Access, you are using standard telephone lines to connect to a server. If you call a server outside your local calling area, you will be billed for any toll charges or long-distance charges.

The following guidelines can help keep your long-distance phone charges to a minimum:

- Do not open applications such as word processors, spreadsheets, and graphics programs on the remote network. Because information must travel over telephone lines, commands may take an extraordinarily long time to complete.

- Prepare files as much as possible before you make a connection. For example, if you need to write a cover memo for your file, do it before connecting to the remote server.

- Use the Connection Reminder option. This keeps you from forgetting that you are connected and inadvertently running up your phone bill.

- While you're using file server volumes, don't leave their windows open. These windows are updated periodically, causing unnecessary network traffic.

- As soon as you finish using a file server volume, disconnect from the server.
- Disconnect from any server volumes you aren't using.
- Close the Chooser.
- Avoid using the AUTOMATIC protocol option if you know the remote server's protocol. Remote Access takes longer to connect because it has to determine the actual protocol.

*Note:* If the server you're calling has the callback option turned on, it disconnects your call and immediately calls you back. The server then originates the phone connection and becomes responsible for the charges.

### Using the Activity Log

The Activity Log automatically documents all Remote Access events. It keeps track of when a Remote Access connection is attempted, established, or disconnected. Follow these steps to view the Activity Log:

1. **Open the Remote Access control panel.**
2. **From the RemoteAccess menu, choose Activity Log.**

The Activity Log window appears. To view more detailed entries, click Options in a Remote Access configuration and select “Use Verbose Logging” in the Connection section of the Options dialog box.
If there are many documented events, you may see a dialog box encouraging you to export the contents of the log to a file for storage and then clear the log of its contents.

A line at the top of the Activity Log window shows the number of entries displayed and the total number of entries in the log file. Because of memory constraints, the Activity Log window may not display all the entries.

**Exporting and clearing the Activity Log**

To save the contents of the log for your records, you can use the Export button in the Activity Log window to save the log entries as a text file.

To export the log:

1. **Click the Export button.**
2. **In the Save dialog box, name the file and open a folder to save it in.**
   By default, the text file is assigned the name Log.
3. **Click Save.**
   After saving the log as a text file, you can use any word-processing or spreadsheet program to view or edit the file.

To clear the Activity Log:

**Click the Clear button.**

Once cleared, the entries cannot be restored.

**Disconnecting from a remote server**

You have four ways to disconnect from a remote server.

- **Using the Disconnect button**
  To disconnect from a remote server using the Disconnect button, open the Remote Access control panel and click Disconnect.

- **Using the Disconnect command in the Control Strip**
  If you have a Control Strip, you can disconnect from a remote server by opening the Control Strip, pressing the Remote Access icon to display the pop-up menu, and choosing Disconnect.
Using Disconnect Remote Access

When you install Remote Access, a file called “Disconnect Remote Access” is installed in your Apple menu. You can quickly disconnect from a remote server by choosing Disconnect Remote Access from the Apple menu. A dialog box appears asking you to confirm that you want to disconnect; click OK, and the connection is closed.

Using the RA Disconnect script

This AppleScript script is in the AppleScript Files folder in your Remote Access folder. Double-click the script icon to close your connection. See Appendix D for a description of AppleScript scripts.

When you disconnect from a remote server, the Remote Access control panel is still open, so you can make another connection or activate another Remote Access configuration.

Note: If your computer is shut down or goes into sleep mode while it is connected to a remote server, Remote Access automatically closes the connection.

Closing connection configuration control panels

You can close any of your connection configuration control panels by choosing the Quit command from the File menu or by clicking the close box in the upper-left corner of the control panel.

IMPORTANT If you are connected to a remote network, closing the Remote Access control panel or any other configuration control panel does not automatically disconnect you. See the previous section, “Disconnecting From a Remote Server,” for ways to disconnect.
Once you've installed the Remote Access Personal Server software on your computer and selected your modem and protocol options, other users can call your computer and use either ARAP or PPP to connect to it. If your computer is connected to an AppleTalk network, other users can also access services that reside on your network, including file services, printing, and electronic mail.

You still have full use of your computer while it answers a call from a remote computer. And you don’t need to have the Remote Access Personal Server running in order to answer calls; as long as your computer is turned on, Remote Access Personal Server automatically answers calls in the background.

This chapter describes how to set up Remote Access Personal Server so that your computer can answer calls.
Setting up Remote Access Personal Server for dial-in access

If you want to give other people dial-in access to your computer, you must set up Remote Access Personal Server to answer calls. When call answering is activated, you can also specify a maximum connection time and, if necessary, set up the connection for access by TCP/IP clients using PPP.

*Note:* Before others can dial in to your computer, you must also configure your modem so that it can accept the connection. See Chapter 2 for information on creating a modem configuration.

**IMPORTANT** When setting up Remote Access Personal Server for dial-in access, you do not need to specify networking protocols. The remote user selects the networking protocol (ARAP or PPP) for the connection. When the client attempts to connect, Remote Access Personal Server detects the protocol type and automatically negotiates a connection.

Follow these steps to set up your server for remote connections:

1. **From the Apple menu, choose Control Panels, and then choose Remote Access.**

The Remote Access configuration window appears.
2 Choose Answering from the RemoteAccess menu.

The Answering dialog box appears.

![Answering dialog box]

Use the controls in the dialog box to set up your computer for answering calls.
(For more information on registering users and setting up access permissions, see the section “Registering Users,” later in this chapter.)

3 Click the Answer calls checkbox.

When this option is selected and your phone rings, your computer answers the call, even if the Remote Access Personal Server control panel is not open.

*Note*: If you have call waiting service on your phone and are connected to another computer or network, a second incoming call will disconnect you. Contact your local phone company to find out how to turn off call waiting while you use Remote Access Personal Server.

4 If you see a dialog box asking you for a password, type the network password assigned to you by your network administrator, and click OK.

On some networks, you may be asked to enter a password before you’re allowed to set up answering on the network. If you do not see the following dialog box when you click the “Answer calls” checkbox, skip to step 5.
Note: If your network requires a password and the “Answer calls” option is selected, this dialog box also appears when you turn on your computer.

5 Click the “Maximum connection time” checkbox, then set the maximum connection time in minutes.

To ensure that remote connections aren’t left idle for a long period of time, you can set your computer to disconnect them after a specified amount of time. The amount of time you choose depends on what type of tasks you expect the person calling your computer to do. Make sure to account for slower transmission rates and to allow users enough time to complete procedures.

Note: If you do not select this option, the user can remain connected for an unlimited period of time. However, you can disconnect a user directly, as discussed in the section “Monitoring and Disconnecting a User” in Chapter 5.

6 Determine whether you want users to have access to the entire network or just to your computer.

If you click the “entire network” button, callers can access all the services on the network that allow guest access or for which they have accounts. If you click the “this computer” button, callers have access to only your computer and the services available on it, such as folders you’ve set up for file sharing.

7 If you want remote users on a TCP/IP network to connect with your computer, click the “Allow TCP/IP clients to connect using PPP” checkbox.

If you are permitting PPP connections through TCP/IP, you must also provide an IP address for the remote client, either by using the client’s existing IP address, or by specifying a default IP address at the server.

8 Type an IP address in the Default IP address field, or click the “Allow client to use own address” checkbox.

9 Click OK to close the Answering dialog box.
Registering users

To control who has access to your Remote Access Personal Server, you can set up permissions that identify each user and give each one a password. You can register as many as 100 users. If you choose, you can also allow guests to call, as explained later in this chapter. Before any user or guest can call, a corresponding user or guest icon must exist in the Users & Groups control panel on your computer.

Working with personal file sharing and AppleShare file servers

Remote Access Personal Server uses the same Users & Groups control panel that is used for personal file sharing and program linking. If you've already set up a user for file sharing, use the same user icon to set up the user's remote access to your computer.

If you are running Remote Access Personal Server and AppleShare on the same computer, the AppleShare permissions settings will always override the Users & Groups settings for both personal file sharing and Remote Access.

To ensure the correct permission settings for anyone dialing into the Remote Access Personal Server, register your remote users through the AppleShare administration utility provided with AppleShare. See your AppleShare administrator's guide for more information.

For more information on setting up permissions with Users & Groups, see your Mac OS documentation.

Naming a registered user (Users & Groups control panel)

The Remote Access Personal Server software automatically sets up a user file for you as owner of your computer, using the owner name specified in the Sharing Setup control panel for personal file sharing. (If you haven't specified an owner name in the Sharing Setup control panel, you can either open that control panel and fill in the owner name and password information or follow the steps below to create a user file for yourself.)
IMPORTANT If you are running Remote Access Personal Server and AppleShare on the same computer, do not set remote access permissions through the Users & Groups control panel. See the previous section, “Working With Personal File Sharing and AppleShare File Servers,” for more information.

Follow these steps to register a user (or to create a user file for yourself):

1. **Make sure the Remote Access Personal Server program is open.**

2. **Choose Users & Groups from the RemoteAccess menu.**
   
   *Note:* You can also choose Control Panels from the Apple menu and double-click the Users & Groups icon.

   The Users & Groups window appears, displaying icons that represent you, the owner of the computer, and any other users and groups of users to whom you’ve extended access privileges.

   ![Users & Groups Window](image1)

   *Note:* By default, Owner automatically gets dial-in access (without callback).

3. **Choose New User from the File menu.**

   An icon titled “New User” appears.

   ![New User Icon](image2)

4. **Type the name of the person you want to register.**

   When connecting to your computer, the user must type the user name you specify here (although capitalization does not matter). Make sure you tell the user the registered name you’ve specified here.
Assigning a password and allowing a user to connect

Assigning passwords to registered users is one way of making sure that only authorized callers can gain access to your computer.

**IMPORTANT** When you authorize people to dial in to your computer, make sure that you enter an owner password for yourself in the Sharing Setup control panel. Otherwise, someone could dial in using just your name and gain access to your entire hard disk.

Follow these steps to assign user passwords:

1. **In the Users & Groups control panel, double-click a user icon to open it.**

   The user’s information window appears, displaying the Remote Access options at the bottom of the window. (For information on the file sharing and program linking options in the window, refer to the manual that came with your computer or to your system software documentation.)

2. **Type a password in the User Password text box.**

   The user must type this password to call your computer. The password can be up to eight characters long and should contain some numerals or punctuation characters to make it harder for unauthorized people to log in. Make sure you tell the user the exact password, including capitalization.
3 If you want to allow this user to change the password, click the “Allow user to change password” checkbox.

4 Click the “Allow user to connect” checkbox.

5 Click the “Allow user to dial in” checkbox.
   This lets the user call your computer. Later, if you want to revoke this user’s dial-in access, you can click the checkbox again to deselect this option.

6 If you want to turn on the callback option, click the “Call back at #” checkbox and type the caller’s telephone number.
   When someone calls your computer and is validated as a registered user, Apple Remote Access temporarily disconnects the caller and immediately dials the number you’ve entered. This optional feature provides an extra level of security because it verifies that the caller dialed from the number you specified.

   Enter the callback phone number as if you were dialing directly, including the area code if necessary. If your computer needs to dial an outside line (as in many business phone systems), type the outside line number followed by a comma. For example, type 9,5551234.

   The comma causes the modem script to pause 2 seconds before dialing the rest of the phone number. You also need to insert a comma after entering numbers such as country codes and city codes. You can type hyphens in the number to make it easier to read, but it is not necessary.

   *Note:* If you turn off the callback option, the phone number remains but is unused.

7 Close the user information window.
   A dialog box appears asking whether you want to save the information. Click Save. The user is now registered and authorized to log in to your computer.
Allowing guests to connect to your computer

Remote Access Personal Server provides you with the option of allowing unregistered users, called guests, to access your computer. Guests can access files and network resources that are set up with guest access. Unlike registered users, guests do not have to enter a user name or password when logging in to your computer. Follow the steps below to set up a guest user.

**IMPORTANT** When you allow your computer to accept calls from guests, you cannot specify a password or turn on the callback option. It is strongly recommended that you do not allow guest access if your computer or network contains sensitive information.

1. **Choose Users & Groups from the Apple menu.**
2. **Double-click the <Guest> icon.**
   
The <Guest> user window opens.
   
   ![](guest_window.png)
   
   The Remote Access options are displayed at the bottom of the window, under the options for file sharing and program linking.

3. **Click the “Allow guests to dial in” checkbox.**
   
   Selecting this option lets guest users call your computer. Later, if you want to prevent guests from calling, click this checkbox again to deselect it.

4. **Close the <Guest> window.**
   
   A dialog box appears asking whether you want to save the information. After you save the information, your computer will accept calls from any guest.
Preventing remote connections to your computer

Follow these steps to prevent users from connecting to your computer through Remote Access Personal Server:

1. **Make sure the Remote Access Personal Server control panel is open.**
2. **Choose Answering from the RemoteAccess menu.**
   The Answering dialog box appears.
3. **Click the “Answer calls” checkbox to remove the X.**
   With answering disabled, no one, regardless of access privileges, can connect to your computer. If you want to prevent access by specific users or guests, you can revoke or modify their access privileges. Specifying access privileges is covered earlier in this chapter, in the sections “Assigning a Password and Allowing a User to Connect” and “Allowing Guests to Connect to Your Computer.”

Switching your server from a nonsecure to a secure network

If you switch your Remote Access Personal Server from a nonsecure network to a secure one—either by changing the physical link or by switching to a different port using software—call answering remains on.

**IMPORTANT** When switching from a nonsecure to secure network, you are not prompted for a password until a remote user tries to dial in or you restart the computer that you set up for dial-in access. You can also force a password prompt by reopening the Answering dialog box, then closing it.
Closing the Remote Access control panel

You can close the Remote Access control panel by choosing the Quit command from the File menu or by clicking the close box in the upper-left corner of the control panel.

**IMPORTANT** If you are connected to a remote network, closing the Remote Access control panel or any other configuration control panel does not prevent users from connecting. As long as your computer is on, it can still answer calls from users.

*Note:* You'll need to open the Remote Access control panel if you want to check a user's status in the Remote Access Status area or look at the Activity Log (the Status area and Activity Log are discussed in Chapter 5).
Managing Remote Connections to Your Computer (Remote Access Personal Server Only)

Remote Access Personal Server provides you with several ways to monitor the use of your computer by other users. You can check to see which users are connected to your computer and how long they have been connected. If you choose, you can disconnect one or more users from your computer. In addition, you can refer to the Activity Log, which is automatically generated by the Remote Access Personal Server software, to keep track of all Remote Access Personal Server activity on your computer.
Monitoring and disconnecting a user

When a user calls your computer, the status area of the Remote Access configuration window displays information about the client connection, including the user's name and how long the user has been connected. You also use the status area to disconnect a user, as explained in the following steps.

1. **From the Apple menu, choose Control Panels, and then choose Remote Access.**

   The Remote Access configuration window appears.

2. **Click Disconnect to disconnect the user.**

   After you begin the disconnection process, the Remote Access Status window displays a Cancel button. Clicking Cancel halts the disconnection process. The user then receives a message indicating that the disconnection process has been stopped, and the user can remain connected for the amount of time you've specified in the Remote Access configuration.

**Disconnecting a user with Remote Access Disconnect**

You can disconnect a user immediately, without having to open the Remote Access Personal Server program, by choosing Remote Access Disconnect from the Apple menu. A dialog box appears asking you to confirm that you want to disconnect the user. Click OK and the user is disconnected.
Tracking remote connections with the Activity Log

The Activity Log automatically documents all Remote Access events. It keeps track of when a Remote Access connection is attempted, established, or disconnected. The Activity Log retains the most recent Remote Access activities. Follow these steps to view the Activity Log:

1. **Open the Remote Access control panel.**
2. **From the RemoteAccess menu, choose Activity Log.**

   The Activity Log window appears. To view more detailed entries, click Options in a Remote Access configuration and select “Use Verbose Logging” in the Connection section of the Options dialog box.

   ![Activity Log Window](image)

   The first two columns show the date and time of each activity. The third column displays the name of the user making the call and describes the activity. An exclamation point (!) precedes an unusual activity, such as an unknown user trying to call or a user trying to connect with an incorrect password.

   *Note:* For instructions about saving or clearing the Activity Log, see “Exporting and Clearing the Activity Log” in Chapter 3.
Appendix A  Using Modems With Remote Access

Apple Remote Access includes modem scripts (programs that can run automatically) that make it possible for you to use many popular Hayes-compatible modems. (Hayes Microcomputer Products, a major manufacturer of modems, developed a language for controlling modems that has been widely adopted. Any modem that recognizes Hayes modem-language commands is said to be *Hayes-compatible.*)

Each modem script contains program code used by the Remote Access software to communicate with that particular modem type. For the most up-to-date list of modems that have scripts included with the Remote Access software, refer to the Read Me file in the Remote Access Client or Remote Access Personal Server folder on your hard disk.

This appendix discusses what you can do if the script for your modem is not included with the Remote Access software. In addition, this appendix covers modem cable requirements, describes how to connect a typical modem to a typical computer running the Mac OS, and lists standard modem commands.
If your modem isn't listed in the Modem control panel

The modem script for your modem might not be properly installed. Refer to the Read Me file on your installation disk for the list of modem scripts that came with Remote Access. Modem scripts should be in the Modem Scripts folder, which is located in the Extensions folder (in your System Folder). You can find the latest versions of modem scripts for Remote Access on one of the many ftp mirror sites that provide updates to Macintosh software, such as ftp.apple.com. The software update is stored on the following path:

Apple Software Updates
US or Worldwide
Macintosh
Networking and Communications
Apple Remote Access

If the modem script you want is not provided with Apple Remote Access, contact the modem manufacturer and see if the script is available through a Web site, BBS, or technical support line.

You can also use ftp.apple.com or other ftp mirror sites to find modem scripts written by users and made available free of charge as unsupported software. You'll find these scripts stored on the following path:

Apple Software Updates
US or Worldwide
Macintosh
Unsupported
User Contributed CCLs

Writing modem scripts

Modem scripts for many popular modems are included with the Remote Access software and are installed when you install the software.
If you need to write a custom script for the modem you are using for connection, you can create one using the Apple Modem Script Generator, an unsupported tool that simplifies the process of creating modem scripts. The Apple Modem Script Generator provides a front-end for entering modem-specific parameters into a template CCL script. (A script generated by this tool may require some manual fine tuning.)

**IMPORTANT** Do not attempt to use the Apple Modem Script Generator unless you have experience writing modem scripts. Apple does not provide technical support for anyone attempting to write their own modem scripts.

The Apple Modem Script Generator is available within the Extras folder on the CD-ROM provided in your Apple Remote Access product package. It can also be found on one of the many ftp sites providing updates to Macintosh software, such as ftp.apple.com.

**Connecting your modem**

How you set up your modem depends on the type of modem you're using. For specific details on how to connect your modem to your computer, refer to the documentation that came with your modem. Depending on the type of modem and computer you use, you'll need to do the following:

- Connect your modem to your telephone line.
- Connect your modem to your telephone (optional).
- If your modem is external, connect it to your computer.
- If your modem is external, connect a power supply to it (unless it is a modem that draws power from the computer).
Modem cable requirements

Most modems require a cable that supports the data terminal ready (DTR) signal. Certain modems require a cable that also supports clear to send/ready to send (CTS/RTS or just CTS) hardware flow control. To support DTR, the cable must connect pin 20 on the DB-25 connector to pin 1 on the Mini DIN-8. To support CTS/RTS, the cable must connect pin 5 on the DB-25 connector to pin 2 on the Mini DIN-8 and pin 4 on the DB-25 connector to pin 1 on the Mini DIN-8. Contact your modem manufacturer or your Apple-authorized dealer or service provider to obtain the necessary cable.

Modem commands

Most modems available in the United States can interpret standard commands. You enter these commands as characters in the telephone number sent to the modem. The following table lists standard commands, but you should refer to your modem manual for a complete description of the commands it interprets.

<table>
<thead>
<tr>
<th>Command (character)</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>0–9, #, *</td>
<td>Characters used for dialing</td>
</tr>
<tr>
<td>T</td>
<td>Causes all digits following to be touch-tone dialed (the default)</td>
</tr>
<tr>
<td>P</td>
<td>Causes all digits following to be pulse dialed</td>
</tr>
<tr>
<td>,</td>
<td>Pauses before continuing</td>
</tr>
</tbody>
</table>

Touch-tone and pulse dialing

You can specify whether you're dialing from a touch-tone or a rotary (pulse) phone by selecting the appropriate Dialing option in the Modem control panel. As an alternative to setting this option, you can precede the telephone number you enter in the Remote Access control panel with a T (for touch-tone) or a P (for pulse), as shown here:

P1,818-555-1234
If you need a combination of pulse and touch-tone, precede the numbers with P (for pulse) and T (for touch-tone) as appropriate. You may need to do this if you're making a long-distance call with pulse dialing and you first connect to your long-distance carrier and then enter an access code using touch-tone. In this case, the phone number you enter should look something like this:

P1,818-555-1234 T342

**Adding a wait state**

For instances where you may be required to enter a credit card number or some other type of access number, you can use the W (for wait) dialing modifier to instruct the modem to wait for a dial tone before sending the next digit in a dialing string. For example:

ATDT818-555-1234W64599865

*Note:* Make sure that your modem supports the W modifier before using it in a dialing string.

**Blind dialing**

Most modems also support “blind dialing” where the modem waits a specified number of seconds and then begins dialing without checking for a dial tone. You can enable blind dialing with the X command and the S6 register. See your modem documentation for more information. For example:

ATS6=10

ATX1DT818-555-1234 s
Appendix B  Troubleshooting

This appendix discusses problems you may encounter while using Remote Access Client or Remote Access Personal Server and offers suggestions for solving these problems. If these suggestions do not solve your problems, call the Apple Assistance Center, using the number supplied in the support information provided with your software. You can also find support information on the World Wide Web at http://support.apple.com or http://www.info.apple.com.

You are unable to make a call.

If you can't make a call, something may be wrong with your telephone line, your modem, or the modem setup.

- Make sure your modem is connected properly and turned on. Refer to your modem documentation if you have any problems.
- Make sure your modem type and port are correctly selected in the Modem control panel.
- Confirm that your phone line is working properly. Connect a telephone to the phone jack used by the modem and make a voice call.
- Verify that you're getting a normal dial tone. Some voice mail systems use a beeping dial tone to notify you of waiting messages. If this is the case, use the AT command ATX3 to instruct the modem to ignore dial tone. Check the documentation supplied with your modem.
You can't hear the modem working.

Most modems have built-in speakers that let you hear that the modem is working. While connecting to a remote server, you can hear the dial tone, the tones of the numbers being dialed, and the sounds of the modems communicating with each other. After a connection is successfully established, the modem typically turns the speakers off. If you can't hear these sounds, try the following:

- Make sure that the Sound option in the Modem control panel is set to On.
- If your modem has a volume control, make sure that it is not turned all the way down.
- Some internal modems may require special software to produce sound. Check with your modem manufacturer.

You are unable to connect to a server.

If your modem is working but you can't connect to the server, try the following suggestions, in the order in which they are listed here, until you are able to connect:

- Verify the phone number of the server you're trying to call. Dial the number using a regular telephone and listen for the “whistle” of a modem. Make sure that you're calling the type of server for which you've set up Remote Access.
- Make sure you're a registered user on the server or that the server is set up for guest access. If you try to connect as a registered user, check that you've entered your user name and password correctly. Some types of servers require passwords that are “case-sensitive”—capitalization matters.
- You may need to create pauses while the telephone number is being dialed. Insert a comma between parts of the number where a pause might be needed. Inserting a second comma lengthens the pause. For example, the following entries cause Remote Access to dial “9” to get an outside line, then pause before dialing the rest of the number:

  9, 555–1234
  9,, 555–1234
If your modem supports the wait state feature, you can use the W command to instruct the modem to wait for a dial tone. (See the documentation provided with your modem.)

Make sure you're using the correct modem script for your modem, and that the script came from Apple or the manufacturer of your modem. To test if the problem is your modem and script, try connecting with a different modem.

The server you're calling may require that you log in to a command-line host through a terminal window. Try selecting the “Connect to a command-line host” protocol option. (From the Remote Access control panel, click Options, then click the Protocol tab to display the protocol options.)

The server you're calling lets you connect directly, but you've selected the “Connect to a command-line host” protocol option. Try turning this option off. (From the Remote Access control panel, click Options, then click the Protocol tab to display the protocol options.)

Try deselecting the “Allow error correction and compression in modem” protocol option. (From the Remote Access control panel, click Options, then click the Protocol tab to display the protocol options.)

Check the Activity Log. It may provide an explanation for the failed connection attempt.

Many servers are set up to refuse connection attempts after repeated attempts to connect with an incorrect password. Contact your administrator to confirm that your account is active and your login name and password are correct.

If you are using a high-speed modem (28.8 kbps or faster), your phone line may be too “noisy” to handle the higher modem speeds. If you are familiar with the CCL script language, you can edit the modem script to force a connection at a lower speed. Otherwise, contact your modem's manufacturer for assistance.
You can’t maintain the connection.

If you are losing the connection, check the following:

- Servers sometimes develop problems that disconnect users without explanation. Try calling back later or use an alternate number, if one is available.
- If you have call waiting, an incoming call can interrupt the connection. In the Remote Access control panel, precede the phone number with the code to turn off call waiting. Check with your telephone company to find out the code to use.
- Many servers automatically end a connection if it is inactive for a certain time. Check with your Internet Service Provider or network administrator.
- Some combinations of modems work better than others. Your modem may not be a good match for the modem of the server you’re calling. If possible, try calling an alternate number for the server or using a different modem.
- You may have noisy phone lines. If you can hear a “crackle” during a normal voice call, have your line checked by your phone company.
- If you are using a high-speed modem (28.8 kbps or faster), your phone line may be too “noisy” to handle the higher modem speeds. If you are familiar with the CCL script language, you can edit the modem script to force a connection at a lower speed. Otherwise, contact your modem’s manufacturer for assistance.

You’re using an X.25 connection and your connection attempts fail.

- Contact your network administrator or service provider and confirm that your server is properly set up to receive X.25 calls.
- Make sure you have selected the correct network and network address in the Connection dialog box.
- X.25 does not support the callback feature. If an alert box appears warning you that your connection attempt has failed because callback is not supported, check with your network administrator to ensure that the callback feature is disabled for your account.
- If the problem persists, contact your X.25 network provider.
You are unable to dial manually.

If you have trouble using the Dial Manually feature, contact the modem manufacturer to be sure the modem script has been upgraded to support the latest features available with Remote Access and OT/PPP.

Remote Access connects to the Internet when you start up your computer.

If you don’t want Remote Access to connect automatically to the Internet when you start up your computer, make sure the “Load only when needed” option in the TCP/IP Options dialog box is selected. You open the TCP/IP Options dialog box by clicking Options in the TCP/IP control panel.

TCP/IP applications don’t start PPP automatically.

Be sure that the “Connect automatically when starting TCP/IP applications” option (in the Remote Access control panel’s Connection options) is selected. See “Setting Connection Options” in Chapter 2.

The response time from the remote network is slow.

- If you have been using a 14,400-bps or slower modem, consider upgrading to a 28,800-bps or higher-speed modem.
- Refer to the section “Making Efficient Connections” in Chapter 3 to see if you can save time during the connection.
- Keep in mind that performance may vary according to the load on the network, your modem’s speed, and the condition of the data links.
- Try connecting at different times of the day. Response will be slower during times of peak usage.

You are left waiting for a callback from the server.

- After you make an initial connection with a server, you are disconnected, but the callback never occurs. Check with your network administrator to verify that your callback number is correct, then try again.
- If there is an attempt at callback but connection fails, verify that you are using the correct modem script and try again.
The connection closes unexpectedly.

- If you have call waiting, an incoming call can interrupt the connection. Open the Remote Access control panel and add the code for turning off call waiting to the beginning of your dialing string. Contact your telephone company to find out the correct code.

*Note:* Disabling call waiting only works for calls that you originate. You cannot turn off call waiting on callbacks from the remote server.

**After you connect to a remote network, you have problems with your printer or another device connected to the printer port.**

- Change your network connection to Remote Only in the AppleTalk control panel to redirect AppleTalk and allow you to access a serial device connected to the printer port.

**After you connect to a remote network, you cannot access your local network.**

- Change your network connection from Remote Only to the appropriate connection in the AppleTalk control panel to access your local network.

*Note:* Switching your AppleTalk connection will disable your access to AppleTalk services. You will have to disconnect, then reconnect to enable the AppleTalk services.

**Other programs that use the serial port don’t function properly, you see a dialog box that says the serial port is in use, or your computer freezes during shutdown.**

- Use the Extensions Manager control panel to turn off the Serial Port Arbitrator extension, then restart your computer.

- If another program is incompatible with Remote Access, contact your Apple-authorized dealer or service provider for more information.

- Turn off answering in Remote Access and in other applications set to accept calls (for example, fax software).
Your PowerBook freezes when you put it into sleep mode.

If your PowerBook freezes when you put it to sleep during an active Remote Access connection, make sure that the latest version of GeoPort-Express Modem software is installed on your computer. You can find the latest version of the software on one of the many ftp mirror sites that provide updates to Macintosh software, such as ftp.apple.com. The software update is stored on the following path:

Apple Software Updates
US or Worldwide
Macintosh
Networking and Communications
Apple_Telecom

A modem script does not appear in the Modem pop-up menu in the Modem control panel.

- Open the Extensions folder in the System Folder and make sure that the modem script is installed in the Modem Scripts folder. Some modem scripts are set to install themselves into the Extensions folder. You need to move such scripts into the Modem Scripts folder.

- Contact the modem manufacturer to make sure the modem is compatible with Remote Access Client. Modem scripts for other applications, such as America Online, do not work with Remote Access.

Some modem features, such as manual dialing, do not work.

- Contact the modem manufacturer to be sure the modem script has been upgraded to support the new features available with Remote Access Client version 3.0.

An Activity Log file won’t print properly.

- Do this:
  1. Choose Page Setup from the File menu.
  2. Click the Landscape (horizontal) icon in the Orientations section of the dialog box.
  3. Enter 70% in the Reduce or Enlarge box.
  4. Click OK.
Others are unable to connect to your Remote Access Personal Server.

If your modem is working but others can't connect to the server, try the following suggestions, in the order in which they are listed here, until you are able to connect:

- Open the Remote Access control panel and choose Answering from the RemoteAccess menu. When the Answering dialog box appears, verify that the Answer calls option is selected. If the option is not selected, your modem cannot answer calls from remote users.

- Verify that the remote user is dialing in with the correct phone number of your server. Ask them to dial the number using a regular telephone and listen for the “whistle” of a modem. Also ask the remote user to confirm that he or she is calling the type of server for which Remote Access has been set up.

- Make sure that the caller is a registered user on the server or that the server is set up for guest access. If anyone fails to connect as a registered user, check that that person has entered his or her user name and password correctly.

You can’t locate or access a service or device on the remote network.

- If a service on the remote AppleTalk network has the same address or name as a service on your local network, the conflict may prevent you from seeing the remote service or device. To remove any conflicts, change your network connection to Remote Only in the AppleTalk control panel.

- Contact the administrator of the remote server and confirm that you’ve been given access to the entire network.

Others connected to your Remote Access Personal Server are unable to see AppleTalk services in the Chooser.

- If a remote user changes the type of network connection during an active ARAP connection, the connection is broken and AppleTalk services are dropped.

- If a remote user changes the type of network connection during an active PPP connection, the connection is maintained but only IP services are available. Any AppleTalk services available through the connection are dropped.
- Confirm that Macintosh file sharing or AppleShare is on. Otherwise, server volumes will not be available.
- Confirm that you've enabled access to the entire network in the Answering dialog box.

**Others connected to your Remote Access Personal Server are unable to access IP services.**
- If the remote user is attempting to access TCP/IP services through a PPP connection, you must enable TCP/IP clients in the Answering dialog box.
- Verify that the remote user is not looking for IP services in the Chooser.
- If you are allowing the client to use his or her own IP address, the address must also be valid for the network on which the server is located.
- If you are connected to a remote IP network through MacIP, make sure that you've selected the correct zone in the TCP/IP control panel.

**After you connect to an AppleTalk server, you can see AppleTalk services but cannot change your password.**
- Make sure that the “change password” option is enabled.
- Verify that you are connected through an ARAP connection. You cannot change your password for a PPP connection to AppleTalk services.
- If you have access to AppleShare or Macintosh file service on the Remote Access Server, you may be able to change your password by logging into that server through the Chooser. (This method will work for both ARAP and PPP connections.)

**While connected to my local network, I open an alias for a server volume and the phone starts dialing.**
- If you create an alias for a shared folder or volume while you are connected to a remote AppleTalk network, the alias also stores the information it requires to connect, including protocol settings and dialing information. If you open the alias and Remote Access is unable to locate the folder or volume through the existing connection, it may try to locate the original by using the dial-in information stored in the alias to connect to the service.

*Note:* If you create an alias to a folder or volume on your local area network or a local disk, the alias does not store any Remote Access connection information.
My ISDN connection is unstable.

- Contact your ISP to confirm that the client and server ISDN routers are compatible. If possible, use the ISDN adapter recommended by your ISP.

Remote Access is using only one ISDN “B” channel.

- Verify that your ISDN adapter supports the bonding of “B” channels. This can occur through software configuration or hardware settings. Contact the adapter vendor for assistance.

Remote Access is using both ISDN “B” channels, but reported transmission rates do not reach the upper limit of 128 kbps.

- Apple Remote Access 3.0 cannot recognize transmission rates above 64 kbps and it will not report higher rates, regardless of the actual transmission speeds. The only way to verify that a 2-channel call has been established is if the ISDN adapter provides a visual indication of 112 kbps or 128 kbps.
Appendix C  Using Remote Access With Macintosh PowerBook Computers

If you are installing Apple Remote Access on a PowerBook computer, you need to be aware of the special instructions covered in this appendix.

Preventing unintended disconnections

If your PowerBook is connected to a remote server, Remote Access closes the connection if your PowerBook goes into sleep mode automatically or because you choose Sleep from the Special menu. You can prevent automatic sleep mode by disabling sleep mode in the PowerBook control panel.

Because your PowerBook battery can be quickly drained during an active connection, you can avoid shutdown by keeping your PowerBook plugged into an AC power source.

Using Remote Access on a PowerBook with an internal modem

This section provides answers to some common problems that may arise when using Remote Access on a PowerBook equipped with an Express Modem or other internal modem.
Setting up an internal modem

To use Remote Access on a PowerBook with an internal modem, you need to set up an internal modem configuration in the Modem control panel. Follow these instructions:

1. In the Modem control panel, choose a modem type from the Modem pop-up menu.
2. Choose Internal Modem from the “Connect via” pop-up menu.
3. Click the close box and click Save.

Changing to an external modem

If you want to change from your Express Modem to an external modem, follow these instructions:

1. Open the Modem control panel.
2. Select the appropriate serial port in the “Connect via” pop-up menu.
3. Click the close box and click Save.
4. Connect the external modem to the selected port.

Removing the Serial Port Arbitrator

Disregard the section in the Express Modem Read Me file that tells you to remove the Serial Port Arbitrator from the Extensions folder in your System Folder. Remove the Serial Port Arbitrator only if it is causing problems (for instance, other programs that use the serial port don’t function properly, or you see a dialog box that says the serial port is in use when it is not).
Appendix D  Using Remote Access AppleScript Commands

This appendix provides basic information about the Remote Access AppleScript scripting additions provided with your Remote Access software. It includes descriptions of the example scripts installed with Remote Access, the syntax of the commands in the scripting additions, and a table of Remote Access error codes.

When you install Remote Access, the Installer places a file of scripting additions, Remote Access Commands, in the Scripting Additions folder inside the Extensions folder in your System Folder. After you restart your computer and configure your Remote Access, TCP/IP, AppleTalk and Modem settings, you can control Remote Access with AppleScript scripts that incorporate the additions.

Example scripts

When you install Remote Access using the Easy Install option, the installed files include AppleScript scripts that demonstrate the use of the scripting additions. The example scripts are stored in the AppleScript Additions folder, inside your Remote Access folder.

To run a script, double-click its icon. To view its contents, open the file with the Script Editor application.

You can customize the example scripts to perform specific actions in response to error conditions. Actions can include the display of more detailed information about an error or the execution of another command. (See the table of error conditions at the end of this appendix.)
Running script additions can generate errors from other parts of the Mac OS. For more information on possible errors, see your Mac OS and AppleScript Developer's Kit documentation.

**Remote Access Connect**

Remote Access Connect initiates an Apple Remote Access connection by displaying prompts for user name and password. If no configuration information is explicitly passed to the `RA connect` verb (for example, idle timer or automatic connect) the script uses the settings stored in the active Remote Access configuration.

*Note:* Remote Access Connect does not substitute bullets for characters entered in the password field—you'll need to customize the script if you want a more secure version.

**Remote Access Disconnect**

Remote Access Disconnect terminates the active Apple Remote Access connection. (It does nothing if there is no active connection.)

**Remote Access Reconnect**

Remote Access Reconnect re-establishes a connection that the remote server has terminated. Reasons for termination can include a configuration setting such as a limit on the amount of time a connection can remain idle.

**Remote Access Save Log**

Remote Access Save Log prompts you for the name of a new log file in which to save the text currently displayed in the Activity Log. This script creates an ASCII version of the log file that contains all the log entries. This script is useful for viewing the entire log when memory constraints prevent the display of all entries in the Remote Access log window.
Remote Access Status

Remote Access Status displays the current status of the Remote Access software. If there is no active connection, the script reports a status of idle. If there is an active connection, the script displays information about the connection, including connection time elapsed and time remaining.

Remote Access commands

The section describes the AppleScript commands for Remote Access, including parameters. You can view and modify the commands by opening the Remote Access Commands file with the AppleScript Script Editor application.

*Note:* The parameter types for Remote Access commands are also available in the Remote Access Commands dictionary.

RA connect

Use RA connect to initiate a Remote Access connection.

```
RA connect
[address string] The connection address (telephone number)
[username string] The user name (cannot use guest access)
[password string] The user password (cannot use guest access)
[guestaccess boolean] Guest access (not user name or password)
[protocol PPP/ARAP/automatic] Protocols attempted for connection
[terminal window boolean] Open terminal window
[connect script alias] Use this connect script
[quiet mode boolean] Don't display dialogs
[show status boolean] Display status
[Result: small integer] The result code; see the Remote Access Errors list
```

*Note:* By default, RA connect uses the settings stored in the active Remote Access configuration. You can override configuration information by modifying one or more of the parameters passed to the command. If the active configuration includes all the correct settings for making the connection, RA connect does not require any parameters.
**RA disconnect**

Use RA disconnect to close a Remote Access connection.

**RA disconnect**

[Result: small integer] The result code; see the Remote Access errors list

**RA status**

RA status retrieves status information for the active Remote Access connection.

**RA status**

[Result: RAStatusParam] The current status information

**RA save log**

RA save log saves the contents of the Remote Access log in an ASCII file.

**RA save log**

**to** file specification Name of the file to which the log is saved

[clearing entries boolean] Should the log entries be cleared after saving

[appending boolean] Should the log entries be appended to the disk file?

[Result: small integer] The result code—check the Remote Access Errors list
Class RAStatusParam

This command returns the Remote Access connection status parameters.

Properties:

- **state** unknown/idle/connecting/connected/disconnecting [r/o]  
  State of this connection.

- **seconds connected** integer [r/o]  
  Time connected, in seconds

- **seconds remaining** integer [r/o]  
  Time left for this connection, in seconds. A value of -1 represents unlimited time remaining.

- **user name** string [r/o]  
  The name of the user for this connection

- **server name** string [r/o]  
  The name of the system at the other end of this connection

- **message** string [r/o]  
  The most recent message received for this connection.

- **protocol** PPP/ARAP/automatic  
  Protocols attempted for connection

- **baud** string [r/o]  
  The baud rate established for this connection.

- **bytes in** integer [r/o]  
  Number of bytes received during this connection.

- **bytes out** integer [r/o]  
  Number of bytes sent during this connection.

PPP commands

The section describes the AppleScript commands for PPP, including their parameters. Use these commands to provide backward compatibility with Open Transport/PPP.
**PPP connect**

Use PPP connect to initiate a PPP connection.

**PPP connect**

- **address string**  The connection address (telephone number)
- **user name string**  The user name (cannot use guest access)
- **password string**  The user password (cannot use guest access)
- **guestaccess boolean**  Guest access (not user name or password)
- **terminal window boolean**  Open terminal window
- **connect script alias**  Use this connect script
- **quiet mode boolean**  Don't display dialogs

[Result: small integer]  The result code; see the Remote Access Errors list

*Note:* By default, PPP connect uses the settings stored in the active PPP configuration. You can override configuration information by modifying one of the parameters passed to the command. If the active configuration includes all the correct settings for making the correction, PPP connect does not require any parameters.

**PPP disconnect**

Use PPP disconnect to close a PPP connection.

**PPP disconnect**

[Result: small integer]  The result code; see the OT/PPP errors list

**PPP status**

PPP status retrieves status information for the active PPP connection.

**PPP status**

[Result: PPPStatusParam]  The current status information
**PPP save log**

PPP save log saves the contents of the PPP log to an ASCII file.

**PPP save log**

to file specification Name of the file to which the log is saved

[clearing entries boolean] Should the log entries be cleared after saving

[appending boolean] Should the log entries be appended to the disk file?

[Result: small integer] The result code—check the OT/PPP Errors list

**Class PPPStatusParam**

This command returns the PPP connection status parameters.

Properties:

- **state unknown/idle/connecting/connected/disconnecting [r/o]**
  State of this connection.

- **seconds connected integer [r/o]** Time connected, in seconds

- **seconds remaining integer [r/o]** Time left for this connection, in seconds. A value of -1 represents unlimited time remaining.

- **user name string [r/o]** The name of the user for this connection.

- **server name string [r/o]** The name of the system at the other end of this connection

- **message string [r/o]** The most recent message received for this connection.

- **protocol PPP/ARAP/automatic** Protocols attempted for connection.

- **baud string [r/o]** The baud rate established for this connection.

- **bytes in integer [r/o]** Number of bytes received during this connection.

- **bytes out integer [r/o]** Number of bytes sent during this connection.
Error codes

This section provides descriptions of the error codes that can be returned from Remote Access AppleScript commands. These codes are useful for customizing your script to include responses to specific errors.

*Note:* The Mac OS can also return error codes during the execution of a Remote Access AppleScript command.

<table>
<thead>
<tr>
<th>Code</th>
<th>Error</th>
</tr>
</thead>
<tbody>
<tr>
<td>-7102</td>
<td>Remote Access did not load properly at system startup</td>
</tr>
<tr>
<td>-7103</td>
<td>Remote Access could not set up a port</td>
</tr>
<tr>
<td>-7104</td>
<td>Remote Access is out of memory</td>
</tr>
<tr>
<td>-7105</td>
<td>The requested action is not supported</td>
</tr>
<tr>
<td>-7106</td>
<td>One or more resources are missing from Remote Access installed files</td>
</tr>
<tr>
<td>-7107</td>
<td>The Remote Access Connections file is not compatible with the installed version of Remote Access</td>
</tr>
<tr>
<td>-7108</td>
<td>An action requiring a connection was requested when there was no connection</td>
</tr>
<tr>
<td>-7109</td>
<td>The connection attempt or established connection was terminated by the user</td>
</tr>
<tr>
<td>-7112</td>
<td>An unexpected error with no useful information has occurred</td>
</tr>
<tr>
<td>-7113</td>
<td>One or more of the installed Remote Access files is damaged</td>
</tr>
<tr>
<td>-7114</td>
<td>The requested action could not be performed because Remote Access was busy</td>
</tr>
<tr>
<td>-7115</td>
<td>The Remote Access logical port is in an unknown state</td>
</tr>
<tr>
<td>-7116</td>
<td>The Remote Access logical port is in an invalid state</td>
</tr>
<tr>
<td>-7117</td>
<td>The Remote Access logical port has detected an invalid serial protocol</td>
</tr>
<tr>
<td>-7118</td>
<td>Login is disabled for the given user</td>
</tr>
<tr>
<td>-7120</td>
<td>The server administrator requires the user to enter a password</td>
</tr>
<tr>
<td>-7122</td>
<td>Remote Access could not initialize Open Transport</td>
</tr>
<tr>
<td>-7123</td>
<td>The requested action could not be performed because Remote Access is not fully initialized yet</td>
</tr>
<tr>
<td>-7124</td>
<td>TCP/IP is inactive and can not be loaded</td>
</tr>
<tr>
<td>-7125</td>
<td>TCP/IP is not yet configured</td>
</tr>
<tr>
<td>-7126</td>
<td>PPP is not selected as the TCP/IP interface in the current TCP/IP configuration</td>
</tr>
<tr>
<td>-7128</td>
<td>The requested PPP protocol was rejected by the PPP peer</td>
</tr>
<tr>
<td>-7129</td>
<td>User authentication failed</td>
</tr>
<tr>
<td>Code</td>
<td>Error</td>
</tr>
<tr>
<td>-------</td>
<td>------------------------------------------------</td>
</tr>
<tr>
<td>-7130</td>
<td>PPP negotiation failed</td>
</tr>
<tr>
<td>-7131</td>
<td>Connection was lost unexpectedly</td>
</tr>
<tr>
<td>-7132</td>
<td>The remote side disconnected unexpectedly</td>
</tr>
<tr>
<td>-7133</td>
<td>The remote side is not responding</td>
</tr>
<tr>
<td>-7151</td>
<td>The Remote Access log file is not open</td>
</tr>
<tr>
<td>-7152</td>
<td>The Remote Access log file is already open</td>
</tr>
<tr>
<td>-7153</td>
<td>The Remote Access log entry could not be retrieved</td>
</tr>
<tr>
<td>-7155</td>
<td>Remote Access cannot locate the active System Folder</td>
</tr>
<tr>
<td>-7156</td>
<td>Remote Access cannot locate its Preferences folder</td>
</tr>
<tr>
<td>-7157</td>
<td>There is a preexisting file using a Remote Access type or creator</td>
</tr>
<tr>
<td>-7158</td>
<td>There is a preexisting folder using a Remote Access folder name and location</td>
</tr>
<tr>
<td>-7159</td>
<td>The Remote Access Connections file is not open</td>
</tr>
<tr>
<td>-7161</td>
<td>An unknown control protocol type was received</td>
</tr>
<tr>
<td>-7162</td>
<td>Remote Access received a packet with an invalid length</td>
</tr>
<tr>
<td>-7163</td>
<td>Remote Access received a negotiable option with an invalid value</td>
</tr>
<tr>
<td>-7164</td>
<td>Remote Access received a negotiable option with invalid flags</td>
</tr>
<tr>
<td>-7165</td>
<td>Remote Access ran out of memory while negotiating with the peer</td>
</tr>
<tr>
<td>-7169</td>
<td>Remote Access encountered an error with no useful information</td>
</tr>
<tr>
<td>-7170</td>
<td>Remote Access is in an invalid state</td>
</tr>
<tr>
<td>-7180</td>
<td>The user canceled the password entry dialog</td>
</tr>
<tr>
<td>-7181</td>
<td>The user did not respond to the password entry dialog in time</td>
</tr>
<tr>
<td>-7182</td>
<td>An unknown serial port was referenced</td>
</tr>
<tr>
<td>-7183</td>
<td>The Remote Access logical port is not configured</td>
</tr>
<tr>
<td>-7184</td>
<td>No AppleTalk services’ endpoints are available</td>
</tr>
<tr>
<td>-7185</td>
<td>The modem script ASK or manual dialing dialog was canceled by the user</td>
</tr>
</tbody>
</table>
Appendix E  Additions to the CCL Scripting Language for Connect Scripts

This appendix is provided for users who are familiar with the CCL scripting language.

The following varStrings have been added to the CCL scripting language for the user name and password:

Name: ^11 or ^U
Password: ^12 or ^P

When the connect script is executed, the strings stored in the Name and Password boxes of the Remote Access control panel replace these varStrings. However, when you save a connect script, the user name and password that you entered are replaced by ^U (or ^11) and ^P (or ^12), respectively. This is done so that your name and password are not shown in clear ASCII form for others to see.

The ^U and ^P varStrings are provided as mnemonics for the user name and password. However, you cannot use them as parameters of CCL for commands that require a varString index, such as IFSTR.

For more information on using the CCL scripting language to write connect scripts, see the ARA Modem Scripting Guide provided on the Remote Access CD-ROM. The guide is a PDF file that you can view with Adobe™ Acrobat™ Reader.
### Index

<table>
<thead>
<tr>
<th>A</th>
<th>Page(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>activating connection configurations</td>
<td>33</td>
</tr>
<tr>
<td>Activity Log</td>
<td>26, 64–65, 81, 95</td>
</tr>
<tr>
<td>Administration user mode</td>
<td>36</td>
</tr>
<tr>
<td>Advanced user mode</td>
<td>36</td>
</tr>
<tr>
<td>aliases, creating for servers</td>
<td>61–62, 97</td>
</tr>
<tr>
<td>Apple Assistance Center</td>
<td>89</td>
</tr>
<tr>
<td>Apple Modem Script Generator</td>
<td>85</td>
</tr>
<tr>
<td>Apple Remote Access 3.0</td>
<td></td>
</tr>
<tr>
<td>converting Remote Access 2.x connection documents to 35</td>
<td></td>
</tr>
<tr>
<td>installation requirements for 2</td>
<td></td>
</tr>
<tr>
<td>installing 3–4</td>
<td></td>
</tr>
<tr>
<td>new features viii–x</td>
<td></td>
</tr>
<tr>
<td>overview vii–xi</td>
<td></td>
</tr>
<tr>
<td>setting up 7–39</td>
<td></td>
</tr>
<tr>
<td>using modems with 83–87</td>
<td></td>
</tr>
<tr>
<td>using with PowerBook computers 99–100</td>
<td></td>
</tr>
<tr>
<td>Apple Remote Access Personal Server. See also remote server; server</td>
<td></td>
</tr>
<tr>
<td>AppleShare file servers and 71</td>
<td></td>
</tr>
<tr>
<td>managing remote connections to computer 79–81</td>
<td></td>
</tr>
<tr>
<td>setting up computer as remote server 67–77</td>
<td></td>
</tr>
<tr>
<td>setting up dial-in access for 68–70</td>
<td></td>
</tr>
<tr>
<td>switching from nonsecure to secure network 76</td>
<td></td>
</tr>
<tr>
<td>troubleshooting 96–97</td>
<td></td>
</tr>
<tr>
<td>AppleScript commands 101–109</td>
<td></td>
</tr>
<tr>
<td>AppleShare file servers 71</td>
<td></td>
</tr>
<tr>
<td>AppleTalk control panel 2, 94</td>
<td></td>
</tr>
<tr>
<td>AppleTalk (MacIP) configuration 16–17, 97</td>
<td></td>
</tr>
<tr>
<td>AppleTalk network network protocols and 8, 9</td>
<td></td>
</tr>
<tr>
<td>Remote Only option and 38–39</td>
<td></td>
</tr>
<tr>
<td>AppleTalk Remote Access Protocol. See ARAP</td>
<td></td>
</tr>
<tr>
<td>AppleTalk server connecting automatically to volume on 61–52</td>
<td></td>
</tr>
<tr>
<td>remote network services and 60–61</td>
<td></td>
</tr>
<tr>
<td>troubleshooting 97</td>
<td></td>
</tr>
<tr>
<td>Apple Web sites 89</td>
<td></td>
</tr>
<tr>
<td>ARA Modem Scripting Guide 111</td>
<td></td>
</tr>
<tr>
<td>description of 8</td>
<td></td>
</tr>
<tr>
<td>protocol options for 22–23</td>
<td></td>
</tr>
<tr>
<td>Security option 29–30</td>
<td></td>
</tr>
<tr>
<td>Authentication Failed error message 44</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>B</th>
<th>Page(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Balloon Help xi</td>
<td></td>
</tr>
<tr>
<td>Basic user mode 36</td>
<td></td>
</tr>
<tr>
<td>blind dialing 87</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>C</th>
<th>Page(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>cables, modem 86</td>
<td></td>
</tr>
<tr>
<td>CCL scripting language 111</td>
<td></td>
</tr>
<tr>
<td>changing Remote Access password (ARAP) 62–63</td>
<td></td>
</tr>
<tr>
<td>Chooser 22, 60, 61, 96</td>
<td></td>
</tr>
<tr>
<td>clearing Activity Log 65</td>
<td></td>
</tr>
<tr>
<td>closing</td>
<td></td>
</tr>
<tr>
<td>connection configuration control panels 66</td>
<td></td>
</tr>
<tr>
<td>Remote Access control panel 77</td>
<td></td>
</tr>
</tbody>
</table>
commas (,) in phone number 19–20, 90
command-line host, connecting to 24–25, 46–49
commands
   modem commands 86
   PPP (Point-to-Point Protocol) commands 105–107
Remote Access AppleScript commands 101–109
Remote Access Disconnect command 80
computer
   allowing guests to connect to 75
   allowing registered users to connect to 73–74
   managing remote connections to 76
   preventing remote connections to 79–81
   setting up as remote server 67–77
configuration road map 10
configurations. See connection configurations
Configurations window 14, 32
connecting
   automatically 24, 93
   to command-line host 24–25, 46–49
   to computer 73–74, 75
   to remote server 1, 41–56
   to remote services 43–44
connecting modem 85–87
connection configurations
   activating 33
   creating 11–30, 32–33
   deleting 35
   exporting 34
   importing 35
   locking 37
   modem configuration 42
   Remote Access configuration 8–30, 43
   renaming 34
   saving 33
TCP/IP configuration 42–43
connections. See also remote connections
   configuring a connection 8–10
   monitoring status of 45–46
   setting options for 26–27
   switching connection types during 31
   tips for efficient connections 63–54
   troubleshooting 90–92, 94, 96
connect scripts
   CCL scripting language 111
   command-line host 25, 48–49
   PPP (Point-to-Point Protocol) 24
control panels
   AppleTalk control panel 2, 94
   closing connection configuration control panels 66
   DialAssist control panel 50–60
   Modem control panel 11–13, 84–85, 95
   Remote Access control panel 17, 20, 68–70, 77
   TCP/IP control panel 2, 13–15, 16–17
   Users & Groups control panel 71–72, 73–74
Control Strip x, 45–46, 65
converting Remote Access 2.x connection documents x
creating connection configurations 11–30, 32–33
D
deleting connection configurations 35
DialAssist feature 50–60
dial-in access, Remote Access Personal Server 68–70
dialing
   adding a wait state 87, 91
   blind dialing 87
   commas and 19–20, 90
   manual dialing 49–50
   pulse dialing 86–87
   touch-tone dialing 86–87
   troubleshooting 93, 95, 97
disconnecting from remote server 65–66
disconnecting users 80
E
error codes (Remote Access AppleScript commands) 108–109
error messages 44
EtherTalk network 38
exporting
   Activity Log 65
connection configurations 34, 36, 37
F, G
file sharing 60, 71
frozen system 95
guests, connecting to computer 75

H
hardware requirements 2
help. See also troubleshooting
  Apple Assistance Center 89
  Apple Web sites 89
  Balloon Help xi
  Remote Access Guide xi

I, J, K
importing
  connection configurations x, 35
  connect scripts 48
installation requirements 2
installing Apple Remote Access 3–4
internal modem (PowerBook computers) 85, 99–100
Internet access x, 13, 42. See also PPP
  (Point-to-Point Protocol);
  TCP/IP configuration
ISDN connection 98

L
LocalTalk network 38
locking connection parameters 37
logging connections. See Activity Log

M
Macintosh PowerBook computers, Apple Remote
  Access and 38, 95, 99–100
MacIP configuration 9, 13, 16–17, 43
manual dialing 49–50
memory, requirements for 2
modem commands 86
Modem control panel 11–13, 84–85, 95

modems
  configuring 11–13, 42
  connecting 85–87
  internal modem (PowerBook computers) 85, 99–100
  not listed in Modem control panel 84–85
  requirements for 2, 86
  Serial Port Arbitrator 100
  troubleshooting 89–90, 95
  modem scripts 4, 84–85, 90
  monitoring
    connection status 45–46
    users 80

N, O
networking protocols. See protocols
networks
  AppleTalk network 8, 9, 16–17, 38
  changing network connection 31
  EtherTalk network 38
  LocalTalk network 38
  nonsecure network 76
  preparing to connect to 1
  remote network services 60–61
  Remote Only option and 38–39
  secure network 76
  TCP/IP network 13–17, 14–43
  TokenTalk network 38
  troubleshooting 93, 94, 96
  nonsecure network 76
  Open Transport viii, 2

P, Q
passwords
  assigning to registered users 73–74
  changing 62–63
  exporting configurations and 34
  importing configurations and 35
  incorrect password 44
  secure networks and 76
  Point-to-Point Protocol. See PPP
PowerBook computers, using Apple Remote Access with [38, 95, 99, 100]

PPP (Point-to-Point Protocol). See also
  TCP/IP configuration
    description of 8, 9
    protocol options for 24–25
    setting up a PPP configuration 13–15

PPP (Point-to-Point Protocol) commands 105–107
preferences, setting 20–27
preventing remote connections 76
printing problems 94, 95
problems. See troubleshooting
program linking 71
protocols. See also ARAP (AppleTalk Remote Access Protocol); PPP (Point-to-Point Protocol); TCP/IP
  automatic setting for 8
  setting options for 21–25
  pulse dialing 86–87

random-access memory (RAM), requirements for 2
redial options, setting 27–30
registered users 71–74
Remote Access AppleScript commands 101–109
Remote Access configuration 8–30, 43
Remote Access control panel
  Activity Log in 64–65, 81
  closing 77
  disconnecting users with 80
  setting up 17–20
  setting up dial-in access 68–70
Remote Access Control Strip module x, 45–46
Remote Access Disconnect command 80
Remote Access events, tracking with Activity Log 64–65, 81
Remote Access Guide xi
Remote Access options 20–27
Remote Access password, changing 62–63
Remote Access Personal Server. See also remote server
  AppleShare file servers and 71
  managing remote connections to computer 79–81
  setting up computer as remote server 67–77
  setting up dial-in access for 68–77
  switching from nonsecure to secure network 76
  troubleshooting 96–97
remote connections. See also connections
  managing 79–81
  preventing 76
  tracking with Activity Log 81
remote network services, selecting 60–61
Remote Only option 38–39
remote server. See also Remote Access Personal Server; server
  connecting to 1, 41–56
  connection configurations for 8–30
  creating alias for 61–62, 97
  disconnecting from 65–66
  on TCP/IP network 13–17, 42–43
  remote services, connecting to 43–44
  renaming connection configurations 34
saving connection configurations 33
Script Editor application 101
scripts
  connect scripts (CCL scripting language) 111
  connect scripts (command-line host) 25, 48–49
  example AppleScript scripts 101–103
  modem scripts 4, 84–85
secure network 76
Security option (ARAP) 29–30
Serial Port Arbitrator 100
server. See also Remote Access Personal Server; server
  AppleTalk server 60–62
  creating alias for 61–62, 97
  disconnecting from remote server 65–66
  on TCP/IP network 13–17, 42–43
  setting up Apple Remote Access 7–39
  shared volume, on remote AppleTalk server 61–52
sleep mode, PowerBook computers and 95, 99
switching connection types during active connection 31
System Folder, Remote Access components in 4
system requirements 2
TCP/IP configuration. See also PPP
(Point-to-Point Protocol)
setting up 8–9, 13–17
setting up for remote server 42–43
TCP/IP control panel 2, 13–15, 16–17
terminal window 24–25, 46–47
TokenTalk network 38
touch-tone dialing 86–87
troubleshooting 89–98. See also help
Activity Log file won’t print properly 95
AppleTalk problems 96, 97
Authentication Failed error message 44
callback problems 93
computer freezes during shutdown 94
connection problems 90–92, 94, 96
dialing problems 93, 95, 97
derror codes (Remote Access AppleScript
commands) 108–109
ISDN connection problems 98
modem problems 89–90, 95
modem script does not appear in Modem control
panel 84–85, 90
network problems 93, 94, 96
PowerBook freezes when put in sleep mode 95
printing problems 94, 95
problems making calls 89
Remote Access Personal Server problems 96–97
remote users can’t access IP services 97
Serial Port Arbitrator problems 100
serial port problems 94
slow network response time 93
X.25 connection problems 92
unlocking connection parameters 37
unregistered users. See guests
user mode, selecting 36–37
users
connecting to computer 73–74
disconnecting 80
monitoring 80
registered users 71–74
Users & Groups control panel 71–72, 73–74
verbose logging 26, 64, 81
volumes, shared 61–62
wait state, adding 87, 91
Web sites, Apple 89
X.25 connection 4, 23, 92
Apple Remote Access 3.0

Apple Remote Access Client and
Managing your connection configurations / 32
  Creating a configuration / 32
  Activating a configuration / 33
  Saving a configuration / 33
  Renaming a configuration / 34
  Exporting a configuration / 34
  Importing a configuration / 35
  Deleting a configuration / 35
  Selecting a user mode / 36
  Using the Remote Only option / 38

3  Connecting to a Remote Server / 41
  Connecting to a server / 42
    Configuring the modem / 42
    Configuring TCP/IP / 42
    Configuring Remote Access / 43
    Connecting to remote services / 43
    Monitoring the status of your connection / 45
  Connecting to a command-line host / 46
    Using a terminal window / 46
    Setting terminal window options / 47
    Importing a connect script / 48
    Creating a connect script / 48
  Dialing manually / 49
  Using DialAssist / 50
  Selecting remote network services / 60
  Connecting automatically to a volume on a remote AppleTalk server / 61
  Changing your Remote Access password (ARAP only) / 62
  Making efficient connections / 63
  Using the Activity Log / 64
    Exporting and clearing the Activity Log / 65
  Disconnecting from a remote server / 65
  Closing connection configuration control panels / 66
You have acquired either the Apple Remote Access Client software package or the Apple Remote Access Personal Server package, which includes the Client software. With Apple Remote Access Client software, you can set up your modem to make a remote connection to an Apple Remote Access–compatible server, including an ARA Personal Server version 2.0, 2.1, or 3.0, an ARA Multiport Server, an AppleTalk Remote Access Protocol (ARAP) server manufactured by another company, or any other type of server that uses Point-to-Point Protocol (PPP). Using Apple Remote Access Personal Server software, you can also set up your hard disk as a server and answer calls from other computers.

With Remote Access, you can extend your access to services and resources beyond the boundaries of your local network. For example, a remote connection gives you the same access to information and resources at a remote location that you would enjoy with a local LAN connection. You can check your electronic mail, access files on AppleShare file servers, print on a LaserWriter printer on the network, or access your company mainframe.

With Apple Remote Access, you can connect to your organization's network from any location that provides telephone access, including a home office or various locations while you are on the road. And with support for PPP, you can use Remote Access to connect to the Internet or to servers that support TCP/IP. You can also use PPP to connect to AppleTalk services if the remote PPP server also supports AppleTalk.

In this manual, you’ll learn how to install and use Apple Remote Access 3.0 (ARA 3.0). This manual assumes that you are already familiar with the Mac OS desktop as well as with basic Mac OS skills, such as using the mouse and the Chooser. If you're unfamiliar with these skills, refer to the manuals that came with your computer.
You should also understand basic networking concepts and have experience using network services like electronic mail, file servers, and printers. For more information on the networking features of your computer, see the networking chapter in the manual for your computer or in your Mac OS documentation.

Remote Access Client lets you access services such as electronic mail, file sharing, file service, and printing remotely.

What’s new in Apple Remote Access 3.0

Version 3.0 of Apple Remote Access Client and Apple Remote Access Personal Server is a major upgrade to previous versions of Apple Remote Access. New features include

- Integration with Apple's modern networking architecture, Open Transport. Connection configurations you create with Remote Access can now be saved as Open Transport configurations. This means that you now have a unified way to access all types of network connections, including Remote Access, Internet connections, and local LAN connections.
- Multiprotocol support. Remote Access now provides access to network protocols other than AppleTalk, including the universal standard for multiprotocol connections, PPP (Point-to-Point Protocol). You can now use Remote Access to dial in to a variety of different servers, including UNIX-based servers. And with Personal Server 3.0 installed, a variety of computers can dial in to your computer, including computers running any version of Remote Access Client, Mac OS–based computers running Open Transport/PPP, and PC-compatible computers running Windows 95 or Windows NT (over PPP).
Internet access. Built-in support for PPP means that you can now use Remote Access to connect to the Internet. By creating a Remote Access configuration that dials into an Internet Service Provider’s server or your organization’s intranet, you can have quick access to Internet services, including e-mail, newsgroups and the World Wide Web.

Control Strip module. If your computer supports the Control Strip, the Control Strip will display a module for Remote Access. The module’s pop-up menu contains commands that you can use to open the Remote Access control panel, select configurations, connect to or disconnect from a remote server, and select options for displaying the status of an active connection.

AppleScript support. You can write scripts using Remote Access AppleScript commands. See Appendix D.

Converting Remote Access 2.x connection documents

In previous versions of Apple Remote Access, the connection settings that you needed to dial into and connect to a remote server were saved in a connection document. Because Apple Remote Access 3.0 is integrated into Open Transport, connection documents are no longer required—instead, you save different connection settings as Remote Access configurations that can be modified and activated as required. Apple Remote Access 3.0 has an import utility that converts connection documents into Remote Access configurations. To convert a connection document, click the Import button in the Configurations dialog box. For step-by-step instructions, see “Managing Your Connection Configurations” in Chapter 2.

Note: Existing Open Transport/PPP configurations are compatible with Remote Access—you can continue to access and modify the configurations through the Remote Access control panel.
Onscreen help

Apple Remote Access 3.0 includes two sources of onscreen information that you can consult when you need help: Balloon Help and Remote Access Guide.

Balloon Help explains the function or significance of items you see on your screen. To turn on Balloon Help, pull down the Help menu from the Help icon (the question mark) near the right end of the menu bar and choose Show Balloons. When you point to an item on your screen, a balloon with explanatory text appears next to the item. To turn off Balloon Help, choose Hide Balloons from the Help menu.

If you are using Mac OS version 7.5.3 or later, you have access to Remote Access Guide, a series of onscreen instructions that teach you how to use Remote Access. To display Remote Access Guide:

- Click the question mark icon that appears in the lower-left corner of Remote Access windows.
- Choose Remote Access Guide from the Help menu when the Remote Access control panel is open or while you are connected to a remote server with Remote Access.